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Introduction

Thefirst thing you need to know is this is not a manual. It will not tell you which operating system any given
version of EndNote is compatible with or how much RAM you need to run EndNote. It will not try to cover
each finicky detail of what EndNote can do.

So, what is it?

This is an ebook of instructions on how to accomplish specific tasks in EndNote, such as importing
references from a specific online database. The author will try to keep the screenshots and instructions as
current as possible, which means there may be frequent new editions of this book. The goal will always be
the same, though—to teach you how to make EndNote do the things you want it to do.

Please note that menu colors may be different than those shown depending on your operating system and
system color preferences.

Thank you for using EndNotel!
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1 Installing EndNote

This chapter will have two main sections, one for administrators who want to create basic site license
installers for their EndNote users, and one for users. Both sections will be detailed, with step-by-step
instructions and screenshots.

EndNote can be installed on multiple computers just as a single user would install it, entering the product
key for every installation. However, it is not necessary to enter the product key for every installation if the
administrator creates or uses a site license installer.

Please note that you will need an administrative level of access sufficient to install software on your
computer and that security software or operating system security settings may stop the installation process
at various times and ask your permission to continue. You must choose the option to continue for the
software to be installed.

Please also note the network administrator instructions will only work for site license/volume installations.
They will not work for single-user installations.

1.1 For Administrators

1.1.1 Creating a Site License Installer for Windows

A site license installer for Windows consists of two files: 1) ENX9/nst.msi and 2) license.dat. These two files
can be distributed to users and the user can install EndNote on their computer without knowing the site’s
product key for the installation. Anybody with knowledge of the product key for the site can create a basic
site installer, with no programming knowledge needed.

e Download the EndNote Windows installer from http://download.endnote.com/downloads/X9/
ENX9Inst.msi (the address is case-sensitive and must be typed exactly as shown).

e Download the ADMIN.zip file from the EndNote LibGuide.

e Extract the ADMIN.bat file by right-clicking on the ADMIN.zip file and selecting Extract All, as shown
below.

}_ Y
s
:“
ENX9Instmsi ADMIN.zip

Open

Extract All...

o This will result in a folder with the ADMIN.bat file inside it. Put the ADMIN.bat file and the
ENX9Inst.msi file together in the same folder or on the desktop. They must be in the same location
to create a site installer.

e Double-click on the ADMIN.bat file to begin creating the site installer.

Copyright © Clarivate Analytics 2018 June 2018
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o When the window below appears, click the Next button.

72 EndNote X9 Setup - X

EndNote X9 Customization Wizard

EndNote X9 customization wizard will:

EndNote*®

- Perform administrative installation of EndNote X9.

- Generate license file {(Volume License Only)

EndNote X9 customization wizard requires:
- Windows Installer 3.0 or later to be installed.
- 180 MB of free disk space.

- Retail or Volume License product key.

Cancel

e In the next window, fill in your school, company, or agency name and the product key. Mark the
box to acknowledge that you have read and accept all terms of the license agreement. Then click
the Next button.

15 EndNote X9 Setup - X

License Information

You must have a valid EndNote X9 product key to perform
administrative installation or generate the license file for internal
redistribution.

EndNote*®

Please enter the software licensing information below:

Licensee:

’EndNole Training

Product Key:

|XXXXX-XXXXX-XXXXX-XXXXX-XXXXX

| hereby acknowledge that | have read and accept all
terms of the license agreement.

q Cancel

Copyright © Clarivate Analytics 2018 June 2018
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e |nthe window below, use the Browse button to select the location the site installer will be created

in, then click the Next button. Do not mark the option “Perform administrative installation.”

@ EndNote X9 Setup

- X

2 Select Destination

2

(=]

=

©

5 Network installation point:

D:\EndNote Training\
[[] Perform administrative installation
q Next > Cancel
e Thenclick the Next button again in the window below.
1% EndNote X9 Setup - X

Admin Installation Verify Ready

Click the Back button to change installation information or click Cancel
to exit the wizard.

EndNote*®

Click Next to begin installation.

Copyright © Clarivate Analytics 2018 June 2018
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e Then the Finish button in the window below.

7 EndNote X9 Setup - X
EndNote X9 has been successfully installed.

Click the Finish button to exit this installation.

EndNote*®

e You should see the site installer files together in your target folder, as shown below. You may now
distribute these two files to users. Some schools zip the files together to make them easier to
distribute. If you decide to zip the files, the user will need to extract them before running the
installation. The installer will not run from a zipped file.

R i

License.dat ENX9Inst.msi

1.1.2 The Site License Installer for Macintosh

Because of changes made in OS X 10.12, Sierra, it is no longer possible for sites to create their own site
license installers for Macintosh. Clarivate Analytics will create all site license installers for Macintosh. The
site license administrator for each site will receive a link to download their custom installer for Macintosh
when they receive their product key. The downloaded site license installer can then be distributed to users.

1.2 For Users

1.2.1 A Custom Installation for a Site License Copy of EndNote on Windows

A typical installation of EndNote installs less than 500 styles, 500 filters, and 500 connection files to
EndNote, even though there are thousands of styles, as well as many more filters and connection files. A

Copyright © Clarivate Analytics 2018 June 2018
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custom installation allows the user to add extra sets of styles, filters, and connection files to EndNote. For
example, a user could add all the humanities styles available to the typical set.

If you have a previous version of EndNote installed, you should uninstall it using Control Panel before
installing the new version.

Your school, company, or agency will need to provide you with two files to install the program, an
ENX9Inst.msi installer and a license.dat file. These two files must be together in the same folder for the
installation to run without asking for a product key. If you are given a zipped file containing these two files,
as in the example file shown below, you will need to extract them from the zipped file before running the
installer. Right-click on the file, then select the Extract All option as shown below.

ENXSInhst.zip

Open

e Use the Browse button to select the folder the files will be placed in after extraction, then click the
Extract button.

| Extract Compressed (Zipped) Folders

Select a Destination and Extract Files

Files will be extracted to this folder:
‘ C:\Users\EndNote Training\Desktop\ENX9Inst ‘ Browse...

Show extracted files when complete

el Extract Cancel

Copyright © Clarivate Analytics 2018 June 2018
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e The files will be extracted to the selected folder. Keep the two files together and double-click on
the ENX9Inst.msi file to start the installation.

| ¥ s | C\Users\EndNote Training\Desktop\ENX9Inst - | X

Home Share View ~ @

& e . T ~ N B~ -
* U = X i - ‘\ﬂ

Pin to Quick Copy Paste - T New Properties Select
access [« folder hd o ~
Clipboard Organize New Open
1t « Desktop » ENX9Inst v O  Search ENX9Inst »p
A ~ .
& This PC [J Name Date modified Type
3 3D Objects r@ ENX9Inst.msi 6/12/2018 1:15 PM Windows In
m Desktop "] License.dat 6/12/2018 3:19 PM DAT File

= Documents

4 Downloads

2 items

e |nthe window below, click the Next button to continue.

15 EndNote X9 Setup - X

Welcome to EndNote X9

Thank you for choosing EndNote X9, the referencing software that
lets you work smarter.

Smarter Teamwork
* Share selected groups of references, manage team access, and
track activity and changes

EndNote*®

Smarter Insights - now powered by Web of Science
* Track the impact of references with Citation Report and find the
best-fit journal for your papers with Manuscript Matcher

Smarter Workflow

* Automatically create, format, and update bibliographies, with the
convenience of remote access online or on your iPad

* Build your bibliography with the latest reference types, including
blogs, multimedia, and social media

* Ensure bibliographic accuracy with new refreshed styles to update
references to key styles such as Chicago, ALA, MLA, and APA

Cancel
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Click the Accept button to confirm that you have permission from your organization to install the
EndNote software. If you do not have permission, you should not install the software.

75 EndNote X9 Setup - X

EndNote X9 Volume License Version

This copy of EndNote X9 s licensed to:

EndNote*®

Licensee: EndNote Training

Serial Number:

By clicking the "Accept” button, | have obtained permission to use this
copy of EndNote X9, and | have accepted the volume license
agreement for EndNote Training, issued by Thomson Reuters.

Click "Cancel" button to quit this installation if you have not obtained
permission to use, or you do not want to accept the license
agreement for this software.

e Nextyou will see the window below, where you can review the Read Me Information. Then click the
Next button to continue.

15 EndNote X9 Setup - X

Read Me Information

EndNote X9 for Windows Read Me A
\Version X9.0
June 2018

EndNote*®

CONTENTS:

I. NEW FEATURES
IIl. INSTALLATIONS
lIl. CONTACT INFORMATION

I.NEW FEATURES

* Manage team input by providing colleagues with
either "write" or "read only" access to vour library v

Cancel

Copyright © Clarivate Analytics 2018 June 2018
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e In the window below, read and accept the EndNote end user license agreement before you click
Next to continue the installation.

75 EndNote X9 Setup - X

License Agreement

EndNote® End User License Agreement "

THE TERMS AND CONDITIONS OF THIS
AGREEMENT SHALL NOT APPLY IF YOU HAVE
OBTAINED ACCESS TO THIS PRODUCT PURSUANT
TO AN INSTITUTIONAL SITE LICENSE. UNDER
SUCH CIRCUMSTANCES, YOUR USE OF THIS
PRODUCT SHALL BE GOVERNED SOLELY BY THE
TERMS AND CONDITIONS OF SUCH LICENSE. If you
would like to understand more about all of the rights that
you or your employer have to use the Product, you
should refer to the institutional site license agreement
between you or your employer and Clarivate or
authorized resellers.

EndNote*®

BACKGROUND. Camelot UK Bidco Limited ("Clarivate v

@ | accept the license agreement

O | do not accept the license agreement

¢ Inthewindow below, decide if you will perform a typical installation or a custom installation. If you
select a Typical installation, a limited set of popular styles, filters, and connection files will be
installed. If you select a Custom installation, you can choose which additional sets of styles, filters,

and connection files will be added to the typical set. The remaining windows will show the options
fora Custom installation. Click Next to continue.

#5 EndNote X9 Setup - X

Select Installation Type

O Typical

All application features and the Most Popular Bibliographic
Output Styles, Online Connections, and Import Filters will be
installed. This option is recommended for the best performance.

EndNote*®

(® Custom

Use this option to choose specific application features and any
Bibliographic Output Styles, Online Connections, and Import
Filters you want to install in addition to the Most Popular files. This
is recommended for advanced EndNote users.

Cancel

Copyright © Clarivate Analytics 2018 June 2018
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e By default, the program will be installed in the C:\Program Files (X96)\EndNote X9\ folder, but you
can change this if you need to. It is best to leave it with the default location unless it is necessary to
putitin anotherfolderfor some reason, such as a lack of space on the C drive. Click the Next button

to continue.
45 EndNote X9 Setup - X
Select Destination
% The Wise Installation Wizard will install the files for EndNote X9in
46 the following folder.
% To install into a different folder, click the Browse button, and select
5 another folder.

You can choose not to install EndNote X9 by clicking Cancel to exit
the Wise Installation Wizard.

Destination Folder

C:\Program Files (x86)\EndNote X%\ Browse ...

Cancel

e Inthewindow below—
1. Clickthe plussign (+) by an option to open it for editing.

2. Clickthe drop-down list button for the sets of styles, filters, or connection files you want to add.
For this example, the set of all Arts and Humanities styles is selected.

3. Select the Will be installed on local hard drive option to add that set of files to the default set.
4. Click the Next button after making all your selections.

EndNote X9 Setup _ >

Select Features

[=}-==I EndNote for Windows ~
©-| EndNote Application
[+]- =+ Word Templates/Add-ins
‘=-| Extension for OpenOffice and LibreOffice
_x -| Additional Connections
o _x -| Additional Filters
x -| Additional Styles
x -| Agriculture
x -| Anthropology

IFX| Arts and Humanities _3
[ = Will be installed on local hard drive.

}E'E Entire feature will be installed on local hard drive.
|© Feature will be installed when required.

| % Entire feature will be unavailable.

EndNote*®

=

Install Direct Export Helper

Disk Cost Reset Next > Cancel

Copyright © Clarivate Analytics 2018 June 2018



@ The Little EndNote How-To Book Page 15

e Note: In the window above you could also click the option (for example, Additional Styles), then
select the option Entire feature will be installed on local hard drive to install all the files for that
option. Please remember for Styles that would install over 6,000 styles.

e Click the Next button again in the window shown below.

4% EndNote X9 Setup - X

Ready to Install the Application

Click the Back button to reenter the installation information or click
Cancel to exit the wizard.

EndNote*®

Before proceeding, make sure you are logged into the local machine
with administrative rights and that no other programs, including
anti-virus software, are running.

Click Next to begin installation.

e Ifyou see a window asking if you want to allow the EndNote application to make changes to your
device, select Yes.

e Click the Finish button when you see the window below saying EndNote has been successfully
installed. You are now ready to begin using EndNote.

#5 EndNote X9 Setup - X
EndNote X9 has been successfully installed.

Click the Finish button to exit this installation.

EndNote*®

Important: Save a copy of the installation files in a safe place in case you need to install EndNote again in
the future.

Copyright © Clarivate Analytics 2018 June 2018
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1.2.2 A Custom Installation for a Single-User Copy of EndNote on Windows

A custom installation for a single user will proceed just as it does for a site license user, except the program
may be installed from a disk or from a single downloaded installation file. The user will be required to input
a product key, then proceed from the Read Me Information as shown above.

1.2.3 Uninstalling EndNote on Macintosh
Previous versions of EndNote should be uninstalled before installing the current version.

e Closeall EndNote libraries, then select Customizer from the EndNote menu to begin.

LGS Gl File  Edit
About EndNote X9

Preferences... 8,
Customizer...
Check for Updates...

e |nthe Customizer window shown below, unmark all boxes, then click the Uninstall button.

EndNote X9 Customizer

Select Components

« Customization Component Installed  Info
« Word Add-in Cite While You Write Cite While You Write addin for Microsoft
« Updating System Serwf:es Servnt:es for Ma-c 0S X
Spotlight Spotlight Indexing
* Summary > Connections Additional Connection Files
» Import Filters Additional Import Filters
» Output Styles Additional Bibliographical Output Styles

EN

? Cancel Uninstall h

e There will be a warning that all external EndNote components will be uninstalled. Click Yes to
continue uninstalling EndNote.

Uninstall will remove all external EndNote components from
) your computer. Are you sure you want to do this?

Copyright © Clarivate Analytics 2018 June 2018
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e When the uninstall finishes you will see the window below. Click the Exit button, then drag the
EndNote folder in Applications to the trash. If you have stored any personal libraries, styles, filters,
or connection files in the EndNote folder, these should first be moved to the Documents folder. In
general, it is best to keep these files in Documents.

EndNote X9 Customizer

« Customization

« Word Add-in EndNote X9 Customizer has removed all components of EndNote that
was previously configured on your computer. You can now remove it
from your machine by clicking 'Exit' and dragging the EndNote folder to
o Summary the trash.

« Updating System

Please take a moment to move any files you have saved or created in the
EndNote application folder to another location prior to dragging it to the
trash.

EN

? el SUCTEE

e You are now ready to begin the installation, described in section 1.2.4 below.

1.2.4 A Custom Installation for a Site License Copy of EndNote on Macintosh

A typical installation of EndNote installs less than 500 styles, 500 filters, and 500 connection files to
EndNote, even though there are thousands of styles, as well as many more filters and connection files. A
custom installation will allow the user to add extra sets of styles, filters, and connection files to EndNote.
For example, a user could add all the humanities styles available to the typical set.

Note that your Security & Privacy settings must allow apps downloaded from the Mac App Store and
identified developers to install EndNote.

If you have a previous version of EndNote installed, you should uninstall it before installing the new version.
You can find instructions for uninstalling recent previous versions of EndNote in section 1.2.3.

Copyright © Clarivate Analytics 2018 June 2018
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e Youshould receive asinglefile called EndNote X9 Site Installer.dmg from your site administrator like
that shown below. Only a site installer can be used to install a permanent volume copy of EndNote
without a product key. Double-click on the site installer to begin the installation.

EndNoteX9Sitelnst
aller.dmg

¢ Inthewindow below, double-click the icon in the center to begin the installation.

[ NON ) | EndNote X9 Installer

EndNote*®

Multi-user & site license
unlocked installer

Install EndNote X9.app

Double click to install EndNote X9 to the Applications folder

e Ifyouseeawindow like the one below, asking if you want to open the application, you will need to
click the Open button to continue the installation.

“Install EndNote X9.app" is an application downloaded

= from the Internet. Are you sure you want to open it?
/TN “Install EndNote X9.app” is on the disk image
“EndNoteX9Sitelnstaller.dmg”. Google Chrome.app downloaded this

disk image today at 12:56 PM from

~ Don’t warn me when opening applications on this disk image

? Cancel Show Dislﬁ Open

Copyright © Clarivate Analytics 2018 June 2018
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e Click the Install button.

@ Install EndNote X9

EndNote X9

Licensed to: The EndNote Team
e Click the Next button in the Welcome to EndNote X9 window below.

EndNote X9 Customizer

Install h

Welcome to EndNote X9

» Welcome
Thank you for choosing EndNote X9, the referencing software that lets
¢ Read Me you work smarter.
« Updating System
Smarter Teamwork

* Share selected groups of references, manage team access, and track
activity and changes

e Summary

Smarter Insights - now powered by Web of Science
* Track the impact of references with Citation Report and find the best-
fit journal for your papers with Manuscript Matcher

Smarter Workflow

* Automatically create, format, and update bibliographies, with the
convenience of remote access online or on your iPad

E N * Build your bibliography with the latest reference types, including
blogs, multimedia, and social media

* Ensure bibliographic accuracy with new refreshed styles to update
references to key styles such as Chicago, ALA, MLA, and APA

? Cancel q
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e Nextyou will see the window below, where you can review the Read Me information. Then click the

Next button to continue.

?

* Welcome

+ Read Me

Updating System

Summary

EN

Cancel

EndNote X9 Customizer

Read Me

EndNote X9 for Macintosh Read Me
Version X9.0
June 2018

CONTENTS:

. NEW FEATURES
Il. INSTALLATIONS
1ll. CONTACT INFORMATION

I. NEW FEATURES

* Manage team input by providing colleagues with either "write" or "read only"
access to your library

* Share a group or view the list of groups shared to you directly from the desktop

* Use Manuscript Matcher to get an informed list of best-fit journals for submitting
your paper

o ST

e Then the Done button in the window below to complete the installation.

« Welcome

Read Me
Updating System

* Summary

EN

EndNote X9 Customizer

Thank you for using EndNote X9

Thank you for using EndNote X9!

Copyright © Clarivate Analytics 2018
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e Thefirst time you open EndNote, it will automatically create an EndNote library for you called “My
EndNote Library” and place it in the Documents folder. It will also show the Welcome to EndNote
guide below. When finished looking through the Welcome to EndNote guide you can close it using
the Close button in the upper-left corner.

® Welcome to EndNote

®
Welcome to EndNote k

Get started by setting up your EndNote account

An EndNote account lets you access your research
from anywhere, anytime - from your desktop,
online or on your iPad.

2
7

Get the app
EndNote*® @

e Toadd styles, filters, and connection files, select Customizer from the EndNote menu.

G IED. Gl File  Edit
About EndNote X9

Preferences... 38,
Customizer...
Check for Updates...
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e Click the small arrow by Connections, Import Filters, or Output Styles to select the type of files you
want to add, then mark the box(es) for the set(s) you want, and click the Next button.

EndNote X9 Customizer
Select Components
» Customization Component Installed  Info
o Word Add-in Cite While You Write Cite While You Write addin for Micros
« Updating System Services Services for Mac OS X
Spotlight Spotlight Indexing
* Summary » Connections B Additional Connection Files
o » Import Filters (-] Additional Import Filters
¥ Output Styles (-] Additional Bibliographical Output Styl
Agriculture Agriculture Bibliographical Styles
Anthropology B Anthropology Bibliographical Styles
Arts and Humanities Arts and Humanities Bibliographical S
Behavioral Sciences Behavioral Sciences Bibliographical S
Business and Econorr Business and Economics Bibliographi
Chemistry B Chemistry Bibliographical Styles
E N Communications and | Communications and Media Bibliograj
Dentistry Dentistry Bibliographical Styles
Ecology Ecology Bibliographical Styles
Education Education Bibliographical Styles
Engineering and Tech | Engineering and Technology Bibliogra
? Cancel Uninstall 9 m

e You will also have the option to customize Cite While You Write if you have not used standard
settings while installing Microsoft Word. Click Customize if you have a nonstandard Word
installation, otherwise click Next.

EndNote X9 Customizer

Cite While You Write for Microsoft Word

« Customization

« Word Add-in The Customizer will install the Cite While You Write add-in for the
instance of Microsoft Word 2008, 2011, or 2016 installed on this

» Updating System computer.

e Summary

If you have installed Microsoft Word to any non-standard paths, or have
changed the Startup folder location, please click the "Customize..."
button.

Customize...

EN

? Cancel #
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e When the Customizer finishes, click Done to finish. You are now ready to begin using EndNote.

EndNote X9 Customizer
Finish
« Customization
« Word Add-in
e Updating System Selected changes have been applied to your computer successfully.
o Summary
? D g DOMe |

Important: Save a copy of the installation file in a safe place in case you need to install EndNote again in the
future.

1.2.5 A Custom Installation for a Single-User Copy of EndNote on Macintosh

An installation for a single-user copy of EndNote will be very much the same as for a site-license copy, with
the addition of needing to provide a product key during the installation.
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2 Using Direct Export to Import References
from Online Databases

2.1 Direct Export from Web of Science

2.1.1 Usingthe Marked List

Web of Science’s marked list provides a useful way to keep track of the references you want to keep when
browsing a large set of search results. References can be added to the marked list as you browse through
them, then exported from the marked list later.

e Perform your search of the Web of Science.

e Markthe references you want to add to the marked list, and click on the Add to Marked List button.

Add to Marked List

e When ready to export, go to the marked list by clicking the Marked List button.

Marked List

10

e You will see a window like the one below with three “steps” for options.

10 records from Web of Science Core Collection
Output complete data from this product for these records.
Output Records [ — Hide OutputOptions] | 5K
Step 1: Select records. Step 2: Select content. Step 3: Select destination.  [Learn about saving to bibliographic software]
® All records in this list (up to 500) Select from the fields below: | [l &4  Save to EndNote online v
All records on page
Records to
| Select All | Reset | Save Custom Settings
¥ Author(s) / Editor(s) 7| Title ¥ Source ¢! Conference Information
) Abstract* | Cited References* ") Document Type - Conference Sponsors
) Addresses ¢! Times Cited ) Keywords - Publisher Information
¥/ ISSN / ISBN | Cited Reference Count Source Abbrev. Page Count / Chapter Count
IDS Number | Language Web of Science Categories Research Areas
Funding Information ¥ Accession Number ¥/ Author Identifiers Usage Count
¥/ PubMed ID ! Open Access ! Hot Paper - Highly Cited
*Selecting these items will increase the processing time.
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e Select the records you want to import in Step 1 of the window, shown below (usually “All records
in this list” if 500 or less).

Step 1: Select records.

® All records in this list (up to 500)
All records on page

Records to

e Select the fields you want to import in Step 2. The example below is from a search of the Web of
Science Core Collection. If you are searching databases outside the core collection, there will be
fewer fields available.

Step 2: Select content.

Select from the fields below:

Select All | Reset | Save Custom Settings

¥ Author(s) / Editor(s) ¥ Title ¥/ Source ¢! Conference Information

¥ Abstract* L) Cited References* ¥/ Document Type ¥ Conference Sponsors

¥/ Addresses ¥ Times Cited ¥ Keywords ¢! Publisher Information

¥/ ISSN / ISBN ¥ Cited Reference Count ) Source Abbrev. ¥ Page Count / Chapter Count
¢ DS Number ¥/ Language ¥/ Web of Science Categories ¥/ Research Areas

¢! Funding Information | Accession Number ¢! Author Identifiers | Usage Count

¥/ PubMed ID ¥ Open Access ¥ Hot Paper ¥ Highly Cited

*Selecting these items will increase the processing time.

e Select Save to EndNote desktop from the drop-down Save to list in Step 3.

Step 3: Select destination.

@ B4 | Saveto EndNote online a

Save to EndNote online

Save to EndNote desktop h

At this point your browser will need to send the file to EndNote. Different browsers will react differently at
this point. Click on your browser below for instructions on how to proceed for your browser the first time
you attempt direct export in that browser. Note that the file type shown will be different for different
databases. For Web of Science it will end with a .ciw extension.

o Firefox on Windows

o Firefox on Macintosh

o Google Chrome on Windows

o Gooqgle Chrome on Macintosh

o Safari on Macintosh

Safari does not support direct export.
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2.1.2 Not Using the Marked List

e Perform your search on the Web of Science and select the references you want to import. Then

select Save to EndNote desktop from the drop-down Save to list.

Save to EndNote online

Save to EndNote online

Save to EndNote desktoph

e You will see awindow like the one below, if you have selected references by marking them, and will

not need to do anything further to select references.

Send to EndNote

2 records selected

Record Content: Author, Title, Source, Abstract

e Ifyou have not selected references, you will see a window like this, and need to select either all the

records on the page or a range of records.

Send to EndNote

Number of Records: ® All records on page

Records ‘ ‘ to

Record Content: Author, Title, Source, Abstract
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e With either of the options above, you will now need to select the fields to export. Select the Full
Record option to get the keywords and author’s address as well as the main bibliographic
information. Note that the Full Record option will only be available when you are searching the
Web of Science Core Collection. If searching outside the core collection, select Author, Title, Source,
Abstract.

Send to EndNote

Number of Records: ‘® All records on page

Records to

Record Content: Author, Title, Source, Abstract A

Author, Title, Source

Author, Title, Source, Abstract

Full Record h

Full Record and Cited References

e Then click the Send button.

Send to EndNote

Number of Records: ® All records on page

Records to

Record Content: Full Record -

qm Cancel

e At this point your browser will need to send the file to EndNote. Different browsers will react
differently at this point. Click on your browser below for instructions on how to proceed for your
browser the first time you attempt direct export in that browser. Note that the file type shown will
be different for different databases. For Web of Science it will end with a .ciw extension.

o Firefox on Windows

o Firefox on Macintosh

o Google Chrome on Windows

o Gooqgle Chrome on Macintosh

o Safari on Macintosh

Safari does not support direct export.
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2.2 Direct Export from PubMed

2.2.1 Using the Clipboard

PubMed's clipboard provides a useful way to keep track of the references you want to keep when browsing
a large set of search results. References can be added to the clipboard as you browse through them, then
exported from the clipboard later.

e Perform yoursearch of PubMed and mark the references you would like to add to the Clipboard on
each page, then click on the Send to link to send the selected references to the Clipboard.

Format: Summary ~ Sort by: Most Recent~ Per page: 20 » q Send to ~

Search results

Items: 1 to 20 of 461 Selected: 2 Page 1 of24 Next> Last>>

#/  High SRPX2 protein expression predicts unfavorable clinical outcome in patients with prostate
1. cancer.

Zhang M, Li X, Fan Z, Zhao J, Liu S, Zhang M, Li H, Goscinski MA, Fan H, Suo Z.

Onco Targets Ther. 2018 May 28;11:3149-3157. doi: 10.2147/0OTT.S158820. eCollection 2018.

PMID: 29881288  Free PMC Article

Similar articles

¥ Multistate outbreak of Salmonella Paratyphi B variant L(+)_tartrate(+)_ and Salmonella Weltevreden
2. infections linked to imported frozen raw tuna: USA, March-July 2015.
Hassan R, Tecle S, Adcock B, Kellis M, Weiss J, Saupe A, Sorenson A, Klos R, Blankenship J,
Blessington T, Whitlock L, Carleton HA, Concepcion-Acevedo J, Tolar B, Wise M, Neil KP.
Epidemiol Infect. 2018 Jun 8:1-7. doi: 10.1017/S0950268818001462. [Epub ahead of print]

PMID: 29880080
Similar articles

e Inthewindow shown below, select the Clipboard option, then click the Add to Clipboard button to
add the selected references to the Clipboard. You can continue adding references to the Clipboard.
Up to 500 references can be kept on the Clipboard for up to eight hours without activity.

Send to ~

Choose Destination

File ® Clipboard

Collections E-mail
Order My Bibliography
Citation manager

Add 2 items.

Add to Clipboard s

e After adding items to the Clipboard, you will see a Clipboard link to the right of the Send to link,
telling you how many items are in the Clipboard. When you have finished adding items to the
Clipboard and are ready to send them to EndNote, click the Clipboard items link.

Send to ~ l:j Clipboard: 2 items

Copyright © Clarivate Analytics 2018 June 2018



@ The Little EndNote How-To Book Page 29

e IntheClipboard screen, click the Send to link, then select the Citation Manager option.

Send to ~ Ej Clipboard: 2 items
Choose Destination

File Collections
E-mail Order
My Bibliography Citation manager

e Click the Create File button.

Send to ~ l‘f_‘| Clipboard: 2 items
Choose Destination

File Collections
E-mail Order
My Bibliography ‘® Citation manager

Generate a file for use with external citation
management software.

Download 2 citations.

Create File h

e At this point your browser will need to send the file to EndNote. Different browsers will react
differently at this point. Click on your browser below for instructions on how to proceed for your
browser the first time you attempt direct export in that browser. Note that the file type shown will
be different for different databases. For PubMed it will end with a .nbib extension.

o Firefox on Windows

o Firefox on Macintosh

o Gooqgle Chrome on Windows

o Gooqgle Chrome on Macintosh

o Safari on Macintosh

Safari does not support direct export.

2.2.2 Not Using the Clipboard

e Perform your search of PubMed. You can mark the references you would like to export on each
page, if you wish. If you do not mark any references, all the references in the found set can be
exported, in batches of up to 200 at a time. Click the Send to link to begin the export process.

Format: Summary ~ Sort by: Most Recent ~ Per page: 20 + ﬁSend to~

Search results

Items: 1 to 20 of 461 Page 1 | of24 Next> Last>>

1. cancer.
Zhang M, Li X, Fan Z, Zhao J, Liu S, Zhang M, Li H, Goscinski MA, Fan H, Suo Z.
Onco Targets Ther. 2018 May 28;11:3149-3157. doi: 10.2147/0OTT.S158820. eCollection 2018.

PMID: 29881288  Free PMC Article
Similar articles
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e Then select Citation Manager.

Send to ~

Clipboard
E-mail

My Bibliography
Citation manager

e Selectthe number of references to exportin the current batch, up to a maximum of 200 references.

Send to ~

Choose Destination

(_File /Clipboard
() Collections _ E-mail
() Order 'My Bibliography

(® Citation manager

Generate a file for use with external citation
management software.

Number to send

20 v

5 m citation
10

|

?go 2 File
200

e Keep track of the end number of the batch so you can repeat the export process for the next batch
with the next consecutive record number. Then click the Create File button.

Send to ~

Choose Destination

(File () Clipboard
() Collections (O E-mail
() Order () My Bibliography

(® Citation manager

Generate a file for use with external citation
management software.

Number to send
20 v

Start from citation
1
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e At this point your browser will need to send the file to EndNote. Different browsers will react
differently at this point. Click on your browser below for instructions on how to proceed for your
browser the first time you attempt direct export in that browser. Note that the file type shown will
be different for different databases. For PubMed it will end with a .nbib extension.

o Firefox on Windows

o Firefox on Macintosh

o Gooqgle Chrome on Windows

o Gooqgle Chrome on Macintosh

o Safari on Macintosh

Safari does not support direct export.

2.3 Browser Actions with Direct Export

2.3.1 Firefox on Windows
e Your EndNote library should be open before attempting to import references.

e Firefoxwill bring up awindow similar to the one below the first time a new export file type attempts
to download. On Windows, you can choose the ResearchSoft Direct Export Helper option or you can
click the Other button to select another program to open the file with.

Opening savedrecs.ciw X

You have chosen to open:

!jg savedrecs.ciw

which is: ISI Common Export Format
from: http://ets.webofknowledge.com

What should Firefox do with this file?

(® Open with |ResearchSoft Direct Export Helper (default) N
p p
O Save File ResearchSoft Direct Export Helper (default)
dNote X9 (Bld 04
[[] Do this auto
Other...
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e Ifyou used the Other option, select the EndNote program to open the file in EndNote, then click the
OK button.

Choose Helper Application X

g ISI Common Export Format

savedrecs.ciw

Send this item to:

- A
g ResearchSoft Direct Export Helper
EN, EndNote X9 (Bld 12043) (s

D Internet Explorer

\ "~

_;] Notepad

B Snagit Editor
v
Browse.q OK

e When returned to the window below, you may select the option to Do this automatically for files like
this from now on. Please note there are several different files types that work with direct export and
you will need to go through this process for each of these file types (.ciw, .ris, .ovd, .enw, .nbib).

Opening savedrecs.ciw X

You have chosen to open:

@ savedrecs.ciw

which is: ISI Common Export Format

from: http://ets.webofknowledge.com

What should Firefox do with this file?

(® Open with  EndNote X9 (Bld 12043) v
(O Save File

Do this automatically for files like this from now on.

Settings can be changed using the Applications tab in Firefox's Options.

q Cancel

e Clickthe OK button to finish the import into EndNote.
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2.3.2 Firefox on Macintosh
e Your EndNote library should be open before attempting to import references.

e Thereis a known issue with direct export and EndNote libraries saved as a package (.enlp) on the
Mac forsome versions of EndNote. EndNote may ask you to select a library even though your library
is already open when importing. Clicking “Cancel” will still import the references. Libraries not
saved as packages will not have this problem. If your library is saved as a package, you can select
Save a Copy from the File menu to create a copy of the library in the standard format. Do not select
the option to save the copy as a package when prompted for the copy’s name and location. After
creating your copy, use the copy as your new EndNote library instead of the packaged file.

e Firefox will bring up a window like the one below the first time a new export file type attempts to
download. To have the file open in EndNote so the references will be imported, click the Choose
button to open the file with an application.

() Opening savedrecs.ciw

You have chosen to open:

savedrecs.ciw

which is: CIW file
from: http://ets.webofknowledge.com

What should Firefox do with this file?

Open with  Choose... h

© save File

Do this automatically for files like this from now on.

Cancel (LD
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e This should bring up a window like the one below. Navigate to the Applications/EndNote folder
and select the EndNote application. Then click on the Open button.

D 32 Bl v B Applications ¢ B a9l Q
Favorites Name ~  Date Modified
& iCloud Drive ¥ i EndNote X9 Today, 1:51 PM
A Applicati » | Cite While You Write Today, 1:45 AM
ppiications » | Connections Today, 1:51 PM
= Desktop B EndNote X9.app Today, 1:39 AM
Bj Documents = EndNote.pdf Today, 1:45 AM
» | | Examples Today, 2:23 PM
o Downloads » [ Filters Today, 1:27 AM
‘m donnakirking License Agreement.txt Today, 1:45 AM
=] onebDrive - Clari... > B Plugins Today, 1:45 AM
» | Product-Support Today, 1:45 AM
E Clarivate Analyti... Readme.txt Today, 1:45 AM
Devices > :er\:llces Togay, 1:45 AM
> [ Spe Today, 1:45 AM
) A
DKWorkBak > [ Styles Today, 1:51 PM
[] U1420704-TPM... > [ Terms Today, 1:45 AM
» | XML Support Today, 1:45 AM
SERE > [7] Epson Software May 14, 2018, 7:39 AM
@ A.. L2 FaceTime.app Jan 18, 2018, 9:34 AM
ﬁ Open

e When returned to the window below, you may select the option to Do this automatically for files like
this from now on. Please note there are several different file types that work with direct export, and
you will need to go through this process for each of these file types (.ciw, .ris, .ovd, .enw, .nbib).

@ Opening savedrecs.ciw

You have chosen to open:

savedrecs.ciw

which is: CIW file
from: http://ets.webofknowledge.com

What should Firefox do with this file?

© Open with EndNote X9 E

Save File

I Do this automatically for files like this from now on. |

Settings can be changed using the Applications tab in
Firefox's Preferences.

el ST

e Clickthe OK button to finish the import into EndNote.
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2.3.3 Google Chrome on Windows

e Upon selecting the option to export from the online database, you will see the items below in the
bottom left corner of the Chrome window. Select the option to Open. (Note that you can also select
the option to Always open files of this type if you are absolutely sure you always want Chrome to
open those files in EndNote in the future.)

9 quen

Always open files of this type

Show in folder

Cancel

| savedrecs.ciw 4 ho

e Ifyou seethe window below, click More apps to see a list of available applications. Unmark the box
to always use this app to open files of this type unless you are absolutely sure you always want this
type of file to be opened by EndNote.

How do you want to open this file?

Look for an app in the Store
More apps \l/h

Always use this app to open .ciw files

OK
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e You will then see a window similar to this, showing you a list of possible applications for opening
the file. Select EndNote from the list. (Notes: This window may be different for different versions of
Windows and Chrome. If you have installed the EndNote online plug-in for Internet Explorer and
have previously set this file type to open, you may not see this window in Chrome. See section 2.4.1.
for more information) Select the EndNote application. Once again, unmark the box to always use
this app to open files of this type unless you are absolutely sure you always want this type offile to be
opened by EndNote. Then click the OK button.

How do you want to open this file?

Look for an app in the Store

@ EndNote X9 (Bld 12019)

Internet Explorer
Notepad
Nuance Power PDF

q’ Paint

Snagit Editor

njajljajo

I Always use this app to open .ciw ﬁIesI

é oK

2.3.4 Google Chrome on Macintosh

The author has found the commands below to work only when using OSX 10.10, Yosemite, or later with
Google Chrome. This has not worked with earlier versions of OSX.

e Upon selecting the option to export from the online database, you will see the item below in the
bottom left corner of the Chrome window. Click the ellipsis (...) to see a list of options.

savedrecs.ciw #

Copyright © Clarivate Analytics 2018 June 2018



W The Little EndNote How-To Book Page 37

e Select the option to Open. (Note that you can also select the option to Always open files of this type
if you are absolutely sure you always want it to open those files in EndNote in the future.)

Always Open Files of This Type

Show in Finder

savedrecs.ciw

e Ifyou seethe window below, click Choose Application to see a list of available applications.

Search the App Store for an application that can open this document, or choose an

There is no application set to open the document “savedrecs.ciw”.
)
existing application on your computer.

? Cannﬁ Choose Application... Search App Store

S

e Select the EndNote application in the Applications/EndNote folder, then click the Open button.

Choose an application to open the document “savedrecs.ciw”.

ED e E My &= # Applications o M 9 Q
Favorites Name ~  Date Modified
¢ iCloud Drive ¥ @ EndNote X9 Today, 1:51 PM
L > Cite While You Write Today, 1:45 AM
A Lol » [ Connections Today, 1:51 PM
[ Desktop B EndNote X9.app Today, 1:39 AM
@ Documents EndNote.pdf Today, 1:45 AM
> Examples Today, 2:23 PM
© Downloads > [ Filters Today, 1:27 AM
m donnakirking License Agreement.txt Today, 1:45 AM
£ OneDrive - CI... » [ Plugins Today, 1:45 AM
» % Product-Support Todav. 1:45 AM

=1 Clarivate Anal...

Options ﬂ Open
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2.4 EndNote Online Plug-In for Direct Export

2.4.1 Google Chrome on Windows

e If you have installed the EndNote online plug-in for Internet Explorer and you have set Google
Chrome to Open file types that are used with direct export instead of save them, you will see a
window like the one below when you use direct export. Select EndNote if you want the search
results sent to your EndNote desktop library. Select EndNote Online if you want the search results
sent to your EndNote online library. See section 5.2 for instructions for installing the plug-in.

Choose Destination

X
meone

EndNote Online Cancel

e If you have not installed the Internet Explorer plug-in, you will need to follow the directions in
section 2.3.3.
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3 Importing PDF Files and PDF Handling

3.1 Importing PDF Files

EndNote can import PDF files containing a Digital Object Identifier (DOI) in the metadata or the first two
pages of the PDF. EndNote sends the DOl to PubMed and CrossRef, online databases capable of looking up
reference data by DOI. The online databases send back the bibliographic information, EndNote imports it,
then attaches the PDF to the record created. This means the PDF must have a DOl and EndNote must have
access to the Internet during the import.

3.1.1 Importing a Folder of PDF Files on Windows

e Select 1) Import from the File menu, then 2) Folder.

EN, EndNote X9

File Edit References Groups Tools Window Help
New...
Open Library... Ctrl+O
Open Shared Library... Ctrtl+Shift+O
Open Recent >
Close Library Ctrl+W l
Save Ctrl+S
Save As...
Save a Copy...
Revert

Share...

Export... a
Import <— (2 N
Print.. * Folder...

Print Preview ‘
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e 1) Click the Choose button, navigate to the folder you want to import, and double-click on it. It will
appear in the Import Folder: field. 2) If you wish to include subfolders within that folder, mark the
box labeled Include files in subfolders. 3) If you want EndNote to create a separate group set for the
main folder and groups within it for the subfolders, mark the box labeled Create a Group Set for this
import. Leave the other settings at their defaults. (Note that EndNote will attempt to attach PDFs
to matching records that already exist in the library instead of creating duplicate records.) 4) When
all your options are set, click the Import button.

Import Folder ? X

’C:\Users\DMK\Desktop\SampIe PDFs\ Choose...

Import Folder:

q Include files in subfolders 9
Create a Group Set for this importh

Import Option: o7 e

Import All v

(4)
Cancel

e The PDF files are imported. Below you see an example of the group set and groups that would be
created for a folder called Sample PDFs that contained a subfolder called Bats and a subfolder

Duplicates:

called Birds.
= Sample PDFs
Bl Bats (6)
B Birds ©)

3.1.2 Importing a Folder of PDF Files on Macintosh

e Selectimport from the File menu.

m<—

New

Open Library... #¥0
Open Shared Library... 30
Open Recent >

Close Library EW

Save a Copy...

Share...

Export...
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e Navigate to the location of the folder of PDFs you want to import. Select the folder, then click the

Options button.

O & [ Desktop 2 th

oo ooo
ee EED] Qunv

Name Date Modified

v [ Sample PDFs
> [ Bats

»> [ Birds

Feb 1, 2018, 6:03 PM
Feb 1, 2018, 6:17 PM
Feb 1, 2018, 6:17 PM

Options <

- Q

Cancel

Size

Import

e IntheOptions, select PDF File or Folder if you do not want EndNote to create a group set and groups
for the imported PDFs, or if you are only importing a single PDF. Select PDF Folder as a Group Set if
you want EndNote to create a group set and groups for the imported PDFs. (Note: The rest of this

example will show the group set option.)

v PDF File or Folder

Import Options:
PDF Folder as a Group Set
EndNote Library

EndNote Import ’
Refer/BiblX

Tab Delimited

Reference Manager (RIS)

ISI-CE

Duplicates:

Text Translation:

Options

Cancel

Import

e |eavetheotheroptions at the default settings and click the Import button. (Note that EndNote will
attempt to attach PDFs to matching records that already exist in the library instead of creating

duplicate records.)

Import Options: PDF Folder as a Group Set

Duplicates:

v
Import All
v

Text Translation: No Translation

Options

ﬂ Import

e EndNote will import the PDFs and create the group set and groups.

Sample PDFs

E_] Bats o
B Birds [ 9
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3.2 Setting PDF Handling

3.2.1 Windows

e Select Preferences from the Edit menu to open the EndNote preferences panel.

Edit rences Groups Tools Windo
un Ctrl+Z

Cut Ctrl+X
S Y S S SN Sy, .y

Import Filters %

Connection V >
Preferences..

e Click the PDF Handling option in the preferences panel to see the window below. Here you can set
automatic renaming options for PDFs you import or set a “watched” auto-import folder. Any PDF
added to the auto-import folder will be imported into the EndNote library. (Note: You cannot put
folders of PDFs in the auto-import folder, only individual PDFs.) Click the OK button when you have
finished selecting your options. (Note: A folder within the auto-import folder will be created to hold
PDFs after they have been imported, so you can easily tell which files have already been imported
and which have not yet been imported.)

EndNote Preferences X

Change Case
Display Fields PDF Auto Renaming Options
Display Fonts
Duplicates
Find Full Text (O Author + Year + Title
Folder Locations
Formatting
Libraries

PDF Handling O Title
Read / Unread O Custom
Reference Types
Sorting

Spell Check
Sync
Temporary Citations Note: Filenames may be up to 50 characters long.

(® Don't Rename

O Author + Title
(O Author + Year

Term Lists
URLs & Links

PDF Auto Import Folder

D Enable automatic importing

I Select Folder

EndNote Defaults Revert Panel q Cancel Apply
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3.2.2

EndNote will check the auto-import folder for new PDFs when a library is opened. After opening
the library, EndNote will scan for new additions to the folder on a schedule. If you continue working
in EndNote and adding PDFs to the auto-import folder, new PDFs added to the folder should be
imported into EndNote within ten minutes of adding them to the folder, but you will need to be
working in EndNote. If you have been working in another program and switch back to the EndNote
window, but do not see your new additions, click on any reference in the list of references to trigger
importing.

Macintosh

Select Preferences from the EndNote X9 menu to open the EndNote preferences panel.
EndNote X9

About EndNote X9

Preferences... 38,

1) Click the PDF Handling option in the preferences panel to see the window below. Here you can
set automatic renaming options for PDFs you import or set a “watched” auto-import folder. Any
PDF added to the auto-import folder will be imported into the EndNote library. 2) Click the Save
button when you have finished selecting your options, then 3) close the window.

® h EndNote™ Preferences

Change Case PDF Auto Renaming Options
Display Fields

Display Fonts © Don't Rename
Duplicates Author + Year + Title
Find Full Text Author + Title

Folder Locations YAUthorBhYear
Formatting _—

Libraries e

PDF Handling <@ Custom

Read / Unread

Reference Types

Sorting

Sync

Temporary Citations Note: Filenames may be up to 50 characters long.
Term Lists

URLs & Links

PDF Auto Import Folder
Enable automatic importing

Select Folder...

EndNote Defaults #
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4 Importing Text Files

Although direct export is a very popular way of importing references from online databases, data can also
be saved as a text file and then imported. Two advantages of saving a text file and then importing it are—

1. Duplicates can be filtered out during the import process, before they enter the library.

2. Ifthe Find Full Text preferences are set to Automatically invoke Find Full Text on newly imported
references, then EndNote will automatically start searching for PDFs to match all the imported
references as soon as the import is finished.

Importing works by pattern matching, so itis very important that the pattern of the data saved matches the
pattern of the EndNote filter used to import it. Check the EndNote filter's About This Filter section for
instructions for downloading data in the correct format to match the filter.

Below are instructions for saving text files from two popular databases, the Web of Science and PubMed.

4.1 Web of Science

4.1.1 Savingthe Data from Web of Science

The method below uses the Web of Science Marked List and will allow you to import the PubMed PMID
number into the Notes field of the EndNote record if you are searching the Web of Science Core Collection.
The instructions are the same for both Windows and Macintosh.

e Perform your search in the Web of Science Core Collection.

e Mark the records you want to save and click the Add to Marked List button.

Save to EndNote online v | Add to Marked List M‘

e Afterselecting all records, click the Marked List button.

12 Clarivate
Analytics

Marked List 10
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e Inthe Marked List, select 1) All records in this list (up to 500), 2) the fields you want exported, and 3)
the Save to Other File Formats option from the Select Destination drop-down list. Please note the
PubMed ID field will only be available if you have limited your search to the Web of Science Core
Collection.

10 records from Web of Science Core Collection
Output complete data from this product for these records.

OutputRecords [ — Hide Output Options] | 5K

Step 1: Select records. Step 2: Select content. Step 3: Select destination. [Learn about saving to bibliographic software]
@® All records in this list (up to 500) | Select from the fieldsbelow: | [l &4 | Save to EndNote online a
- All records on page Save to EndNote online =
- Records to Save to EndNote desktop
Save to ResearcherlD - | wrote these
L) SelectAll | Reset | Save Custom Settings
I Author(s) / Editor(s) ¥ Title ¥l Source Save to FECYT CVN
¥/ Abstract* L) Cited References* ¥/ DocumentTy Save to InCites 6
¥/ Addresses ¥/ Times Cited ¥/ Keywords Save to Other File Formats h
¥/ ISSN / ISBN ¥ Cited Reference Count ¥ Source Abbrﬁ s RefWork ount
¥/ IDS Number ¥ Language %I Web of Scien. >°"© '€ RefWorks v
¥ Funding Information ¥/ Accession Number ¥/ Author Identifiers ¥ Usage Count
¥/ PubMed ID ¥/ Open Access I Hot Paper ¥ Highly Cited

*Selecting these items will increase the processing time.

e Inthewindow below, select 1) Other Reference Software, then click the Send button.

Send to File | X

10 records selected

File Format Other Reference Software h -
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e Ifyou see a window asking if you want to save the file or open it, such as the example below, save
the file. Make a note of the location the file is saved in, EndNote will not know the location. Note
that files saved in this way from the Web of Science have the default name savedrecs.txt. This file
can be emailed to another EndNote user as an attachment for import, if desired. It is just a plain
text document.

Opening savedrecs.txt X

You have chosen to open:

which is: Text Document (33.4 KB)
from: http://ets.webofknowledge.com

What should Firefox do with this file?

(O Open with | Notepad (default)

[[J Do this automatically for files like this from now on.

Cance

4.1.2 Importing the Web of Science File on Windows

e Toimport thefile into EndNote, in EndNote select 1) File, 2) Import, then 3) File.

e, EndNoteg9

File hmols Window Help
a1
Open Lib Ctrl+O

Open Shared Library... Ctrtl+Shift+0
Open Recent >

Close Library Ctrl+W

Save Ctrl+S
Save As...

Save a Copy...

Revert

Share...

Export... e e

import h #me---
Folder...

Print... Ctrl+P
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e Inthe window below, 1) click the Choose button and select the savedrecs.txt file to open. You will
need to know where you saved the file. Then 2) select Other Filters from the drop-down /Import
Option list. Note that after a filter has been used once, it will appear in the drop-down list in the
future.

Import File ? X

I Isavedrecs.txt

Import File:

Import Option: EndNote Library
PDF

Duplicates: EndNote Library
EndNote Import

Text Translation: Refer/BibIX
Tab Delimited
Reference Manager (RIS)
ISI-CE
Multi-Filter (Special)

EndNote generated XML
Use Connection File...

e In the window below select 1) the Web of Science Core Collection filter, then 2) click the Choose

button.

Choose An Import Filter X
Name Information Provider A
Transplant Library (OvidSP) OvidSP
Union Lists (OCLC)

Urban Studies Abs (EBSCO)

Water Resources (EBSCO) (o]

Web of Science Core Collection (Clar... Clarivate Analytics

Wildlife Ecology Studies (EBSCO) EBSCO

Wilson App Sci Tech (OvidSP) OvidSP

Wilson Art Abs (OvidSP) QvidSP

Wilson Art Index (OvidSP) QvidSP

Wilson Human Abs (OvidSP) OvidSP

Wilson Index Legal (OvidSP) OvidSP

Wilson Library Lit (OvidSP) OvidSP

sl Calmns LAY neLe v
Quick Search vl

4 Less Info:

File Name: Web of Science Core Collection (Clarivate).enf
Created: Saturday, June 16, 2018, 2:10:39 PM
Modified: Saturday, June 16, 2018, 2:10:33 PM
Based On:
Category: Clarivate Analytics
Comments: |pOWNLOADING INSTRUCTIONS A

1. Perform a WoS or DCl search as normal.
2. Select the desired articles bv clickina the button to the

v

Showing 366 of 366 import filters.
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e Ifyouthinkyou mightimport duplicates of some of the references in your library, 1) choose Discard
Duplicates from the Duplicates drop-down list, then 2) click the Import button.

Import File ? X
Import File: Isavedrecs.b(t \Choose...
Import Option: IWeb of Science Core Collection (Clarivate) v

v

Duplicates: Import All

Import All
Text Translation: Discard Duplicates

e Import into Dgiolicates L8

| _Import |
e The references will be imported into EndNote and appear in the Imported References group. The
PMID will appear in the Notes field as a number.

Cancel

4.1.3 Importing the Web of Science File on Macintosh

e Toimport the file into EndNote, in EndNote select 1) File, then 2) Import.

New 0

Open Library... #¥0
Open Shared Library... 030
Open Recent >

Close Library BEW
Save a Copy...

Share...

Export... a
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e Inthewindow below, 1) select the folder the file was saved in, 2) select the downloaded file, and 3)
click the Options button.

O 88 EEED S8+ [@ Downloads M & =) Q

Favorites Name Date Modified v Size Kind

E Recents B savedrecs.txt Today, 10:25 AM 34KB  Micros...nt

¢ iCloud Drive
I-\‘ Applications
) Desktop

@ Documents
0 Downloads
ﬁj donnakirking
1 OneDrive

Options h e Cancel Import

e Intheoptions, select OtherFilters from the Import Options drop-down list to bring up a list of import
filters.

PDF File or Folder

Import Options: | v PDF Folder as a Group Set
EndNote Library
Duplicates: EndNote Import
Refer/BibIX

Tab Delimited

Reference Manager (RIS)
ISI-CE

Multi-Filter (Special)
EndNote Generated XML

ﬁ Other Filters...

Use Connection File...

Text Translation:

Options Cancel Import
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e In the window below select 1) the Web of Science Core Collection filter, then 2) click the Choose

button.
| NN ) Choose A Filter
Q Find Name All Filters
Quick Search Find by Category

Showing 362 of 362 filters.

Name ~ Information Provider

Union Lists (OCLC) OCLC

Urban Studies Abs (EBSCO) EBSCO

Water Resources (EBSCO) EBSCO 1
Web of Science Core Collection (Clarivate) Clarivate Analytics

Wildlife Ecology Studies (EBSCO) EBSCO

Wilson App Sci Tech (OvidSP) OvidSP

T

E More Info

e Ifyouthinkyou mightimport duplicates of some of the referencesin your library, 1) choose Discard
Duplicates from the Duplicates drop-down list, then 2) click the Import button.

ED) e2 EIID 8+  [@ Downloads < & | Q

Name Date Modified v Size Kind

Favorites
@ Recents B savedrecs.txt Today, 10:25 AM 34 KB Micros...nt

Import Options: Web of Science Core Collectim

Duplicates: v Import All
) Discard Duplicates
Text Translation: | |mport into Duplicates Library

Options ﬁ Import

e The references will be imported into EndNote and appear in the Imported References group. The
PMID will appear in the Notes field as a number.
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4.2 PubMed

4.2.1 Saving the Data from PubMed

Direct export from PubMed will allow importing of up to 200 records at a time, while saving a text file from
PubMed and then importing will allow you to import thousands of records at a time, if you wish to do so,
and itwill allow you to filter out duplicates during the import. The directions below use PubMed’s clipboard
feature, but records can also be exported directly from the search results screen. Directions for saving data
from PubMed are the same for Windows or Macintosh.

e Perform your search on PubMed’s web site.

e Mark the records you wish to import and 1) click the Send to: button, 2) choose Clipboard as the
destination, and 3) click the Add to Clipboard button. This will add the selected references on the
page to the clipboard. You can then go to the next page in PubMed and select more references.

Send to -4—0

Choose Destination

@) e Ciipboard

'Collections () E-mail
'Order My Bibliography
Citation manager

Add 461 items.

Add to Clipboard \h (3]

e When finished selecting references, click the link showing the number of items in the Clipboard, to
the right of the Send to: button. This will take you to the Clipboard.

Sendto~ [[] Clipboard: 461 itemsh

Copyright © Clarivate Analytics 2018 June 2018



@ The Little EndNote How-To Book Page 52

e In the Clipboard, 1) click the Send to: button, 2) select File under Choose Destination, 3) select
MEDLINE as the Format, and 4) click the Create File button. Note that if you do not select the
MEDLINE format, the file will not import into EndNote correctly.

Send to h o

Choose Destination

o File < @olcctions

~ E-mail _ Order
'My Bibliography 'Citation manager

Download 461 items.

Format

[MEDLINE v | (s €)

Sort by
Most Recent v

e Ifyou see a window similar to the one below, save the file and make a note of where you saved it.
The default file name for files saved from PubMed is pubmed_result.txt. This is a plain text file and
can be emailed as an attachment.

Opening pubmed_result.txt X

You have chosen to open:

D pubmed result.txt

which is: Text Document

from: https://www.ncbi.nlm.nih.gov

What should Firefox do with this file?

(O Open with  Notepad (default) N

@:Save File h

[] Do this automatically for files like this from now on.
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4.2.2 Importing the PubMed file on Windows
e Toimport thefile into EndNote, in EndNote select 1) File, 2) Import, then 3) File.

EN, EndNote X9
File hﬂoups Tools Window Help
New...
Open Library... Ctrl+O
Open Shared Library... Ctrtl+Shift+O
Open Recent >
Close Library Ctrl+W
Save Ctrl+S
Save As...
Save a Copy...
Revert
Share...
Export...
Import h 9 9 q File...
Print... Ctrl+P Folder...

e Inthewindow below, 1) click the Choose button and select the pubmed_result.txt file. You will need
to know where you saved the file. Then 2) select Other Filters from the drop-down list. Note that
after a filter has been used once, it will appear in the drop-down list in the future.

Import File ? X
T Fl pubmed_result.txt Choose...
Import Option: EndNote Library ‘ v

PDF
Duplicates: EndNote Library

EndNote Import
Refer/BibIX a
Tab Delimited

Reference Manager (RIS)
ISI-CE

Multi-Filter (Special)
EndNote generated XML

Text Translation:

Use Connection File...
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In the window below, 1) select the PubMed (NLM) filter, then 2) click the Choose button.

Choose An Import Filter

Name

Information Provider A

v
Ouectel

Quick Search v Find by »
2 |ess Info: 9 ’

If you think you might import duplicates of some of the references in your library, 1) choose Discard
Duplicates from the Duplicates drop-down list, then 2) click the Import button.

Import File ?

X
Import File: ‘pubmed_result.txt ’ Choose...
Import Option: ‘PubMed (NLM) M ‘
Duplicates: Import All b

Import All 1
- Discard Duplicates
Ve MG TE Zi2 8 Import into Duplicates !ibrary
e d Import | Cancel

e The references will be imported into EndNote and appear in the Imported References group. The

PMID will appear in the Accession Number field.
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4.2.3 Importing the PubMed File on Macintosh

e Toimport the file into EndNote, in EndNote select 1) File, then 2) Import.

New o

Open Library... #0
Open Shared Library... 80
Open Recent >

Close Library #EW
Save a Copy...

Share...

Export... g

e |nthe window below, 1) select the folder the file was saved in, 2) select the downloaded file, and
3) click the Options button.

5l a8 E 00 v [@ Downloads M ™ | Q

Name Date Modified v Size Kind

Favorites
@ Recents B pubmed_result.txt ~ 1y,10:42 AM 1.6 MB Micros...nt

Options h 9 Cancel Import
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e Intheoptions, select Other Filters from the Import Options drop-down list to bring up a list of import
filters.

PDF File or Folder

Import Options: | v PDF Folder as a Group Set
EndNote Library
Duplicates: EndNote Import
Refer/BibIX

Tab Delimited

Reference Manager (RIS)

. ISI-CE

Options Multi-Filter (Special)
EndNote Generated XML

q Other Filters...

Use Connection File...

Text Translation:

Cancel Import

e Inthewindow below, 1) select the PubMed (NLM) filter, then 2) click the Choose button.

[ NON | Choose A Filter
Q_ Find Name All Filters
Quick Search Find by Category

Showing 362 of 362 filters.

Name ~ Information Provider

PsycINFO (OvidSP) OvidSP

PsycTESTS (OvidSP) OvidSP

PSYNDEXplus Lit AV (Ov OvidSP

PSYNDEXplus Tests (Ovi OvidSP

PubMed (NLM) National Library of Medicine 1
PubMed Central (NLM) National Library of Medicine

© e W

DMore Info
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e Ifyouthinkyou mightimport duplicates of some of the references in your library, 1) choose Discard
Duplicates from the Duplicates drop-down list, then 2) click the Import button.

Import Options: PubMed (NLM)
Duplicates: v Import All

) Discard Duplicates [ 1
Text Translation: | |mport into Duplicates Library

Options e ﬂ Import

e The references will be imported into EndNote and appear in the Imported References group. The
PMID will appear in the Accession Number field as a number.
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5 EndNote Online

EndNote lets you work on your desktop, online, or on an iPad. This chapter cannot cover everything
EndNote can do online, but it will show you how using plug-ins and capture features of EndNote online can
help you even if you prefer to work on the desktop.

Whether you are upgrading from EndNote basic (online only, with a limited feature set) and merging that
library with your desktop library, or creating an online library for the first time, you need to start by setting
up EndNote Syncto keep all your references and custom groups up to date on both the desktop and online.

5.1 Set Up EndNote Sync

5.1.1 Back Up the EndNote Desktop Library

First, you should make a complete backup copy of your desktop library by saving a compressed library.
Note that EndNote may ask if you want to make a backup when you begin syncing, but you can make a
backup at any time using the method below.

e Select Compressed Library from the File menu in EndNote. You should see a screen like the one
below. Leave the options as shown to save a complete copy of your library with all attachments.

Compressed Library (.enlx) X
(® Create | (® With File Attachments |
(O Create & E-mail (O Without File Attachments
I @AII References in Library: I Sample_Library_X9.enl

O Selected Reference(s)

(O All References in Group/Group Set:  Sample PDFs

Next Cancel

e Click on the Next button to select a location to save the file. This will bring up a standard “save”
dialog window.

e Select the location and click the Save button. It may take some time to compress and save a large
library, so be patient.

e Note that although you cannot safely keep a working EndNote desktop library in cloud services
such as Dropbox, you can keep a compressed library in the cloud for backup purposes. See section
7.5 for more information.
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5.1.2 EndNote Sync

e Ifyou have not already synced your EndNote desktop and online library references, click the Sync
button to sync for the first time. (Note that you may be asked if you want to create a compressed
library as a backup if it is the first time the library has been synced on that computer.)

O

Sync button for Windows: Sync button for Macintosh:

e Ifyou already have an EndNote online or basic account, use that account’s logon information, as
in the example shown below. If you do not have an EndNote online account, you can create one by
clicking the Sign Up button (in the box below). Click the OK button to start the sync. (Note: If you
have a Web of Science account, use the same logon information for your EndNote online account.
This will enable cross referencing between Web of Science and EndNote online.)

EndNote Login X

Using an EndNote account makes it easy to get the latest features and keep your library in sync.
Learn more

Create a new EndNote Account

If you don't have an EndNote account or aren't sure, then click Sign Up. Sign Up

EndNote Account Credentials

E-mail Address: ‘ EndNote.Training@ ‘

Password:

Forgot Password

e Duringthefirst sync, all references in both the EndNote desktop and online libraries will be copied
to the other library, as well as all group information, but only custom groups will be displayed in
EndNote online. So, there may be duplicates and some library clean-up necessary. After the first
sync, any change made in any synchronized library will be reflected in all synchronized copies of
thelibrary. This means if you delete references in EndNote online or EndNote on the desktop, those
references will be deleted in both.
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e Group sets will not show online, but the information will be synced through online to a second
desktop computer, where they will show. Because they do not show online, you may wish to use
short prefixes before custom group names to ensure custom groups that belong together remain
together online, as shown in the example below.

[=/- Avian Intelligence
Bl Al: corvids (19)
B Al: Parrots (24) My References
‘Avian Cognition (31) All My References (59)
_ [Unfiled] (0)
.Corwds & Parrots (6) Quick List (0)
[=/ Bats Trash (0)
E_] Bat: Chiroptera (22) ¥ My Groups
B3 Bat: Echolocati . Al: Corvids (19)
=) Ges Edleerar © Al: Parrots (24)
@ Echolocation OR Sonar (7) Bat: Chiroptera (22)
{(‘ Sonar (5) Bat: Echolocation (6)
Desktop Online

e Although itis possible to create an EndNote online account and not synchronize it to an EndNote
desktop library, syncing will allow you to easily keep the same set of references in both libraries.

e After syncing an EndNote library, you can begin sharing groups to collaborate with other EndNote
basic/online users (see section 7.3) or share your entire library with other EndNote users (see
section 7.2).

5.2 Installing the Internet Explorer Plug-In

You do not need to be using Internet Explorer to install the Internet Explorer plug-in. If you prefer to use
another browser, such as Google Chrome or Microsoft Edge, but want the benefits of direct export with
EndNote online, orif you need to install the plug-in on several computers, use the .msi installer.

Note that the Internet Explorer plug-in will not work with the Firefox browser and is not available on the
Macintosh.
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e On the Downloads page in EndNote online, select Download Windows MSI for mass program

installation.

Cite While You Write™

Use the EndNote plug-in to insert references, and format citations
and bibliographies automatically while you write your papers in
Word. This plug-in also allows you to save online references to
your library in Internet Explorer for Windows.

Patented technology. Australia Patent 2014318392; U.S. Patents
10002116, 9588955, 9218344, 9177013, 8676780, 8566304,
8201085, 8082241, 6233581; China Patent: 201380034689.3;
Japan Patent: 5992404.

See Installation Instructions and System Requirements.

Download Windows with Internet Explorer plug-in
|[Download Windows MSI for mass program installation |
Download Macintosh

Save the file in a location you will remember, such as the Downloads folder.

Navigate to the location you saved the file and double-click the downloaded EndNotePlugins.msi
file to begin the installation.

s | Downloads

s M
Home Share View AN o

v 3k Quick access

EndNotePlugins.msi hl/ZOWB 10:44 AM

m Desktop *
4 Downloads »*
= Documents *
v <

1 item

T - 3 S
x U o & Moveto ™ = X Delete ~ _u v BH
= i~
Pinto Quick Copy Paste Copy to ~ T Rename New Properties Select
access [ folder M @ M
Clipboard Organize New Open
&« v /4 & > This PC » Downloads v O  Search Downloads R
A [0 Name Date modified
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e You will see a message that the installer is searching for installed applications. This message may
remain for several minutes, so be patient.

@ EndNote Plug-Ins Installer -

End Note Welcome to the

EndNote Plug-Ins Installer

Searching for installed applications...

Plug-ins for
Microsoft Word
& Internet Explorer

Cancel

e When the installer has recognized the presence of both Internet Explorer and Microsoft Word, this
message will appear. Click the Next button to continue.

15 EndNote Plug-Ins Installer - X

End NOte Welcome to the

EndNote Plug-Ins Installer

This installer will allow you to install one or both of the following
plug-ins:

* Cite While You Write for Microsoft Word

Plug-ins for * EndNote Capture for Internet Explorer
Microsoft Word
&Internet Explorer Cite While You Write patented technology. Australia Patent

2014318392; U.S. Patents 10002116, 9588955, 9218344,
9177013, 8676780, 8566304, 8201085, 8082241, 6233581; China
Patent: 201380034689.3; Japan Patent: 5992404.

# Cancel
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e Enteryour name and company, then click the Next button.

@ EndNote Plug-Ins Installer

End Note Registration Information

Please enter your name and company below.
All fields are optional.

Name:
’EndNole Training|
Plug-ins for
Microsoft Word
& Internet Explorer O

’CIarivate Analytics

— s Cancel

e The Default server will work for most people. If you believe your school or organization requires a

special server, check with your library for the server address your school or organization requires.
Click the Next button

15 EndNote Plug-Ins Installer - X

End Note Set Server

The EndNote Plug-Ins installer is unable to detect the server for this
installation.

Please select the server

I@ Default (www.myendnoleweb.com)l

Plug-ins for
Microsoft Word

(O Advanced (requires functional server URL)
& Internet Explorer

‘hﬂp:/lwww.myendnoleweb.com/

el Ned> | Cancel
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e You may change the destination folder the program will be installed in, if you wish, then click the
Next button. In general, the default location is best.

75 EndNote Plug-Ins Installer - X

E n d Note Select Destination

The EndNote Plug-Ins installer will install the files in the following
folder:

Destination Folder

C:\Program Files (x86)\EndNote Plug-Ins\ Browse...

Plug-ins for
Microsoft Word
& Internet Explorer

q Cancel ‘

e Because you are using EndNote on both the desktop and online, you do not need the EndNote
online Cite While You Write files. They are already contained in EndNote. From the drop-down Cite

While You Write for Microsoft Word menu, select Entire feature will be unavailable. Then click the
Next button.

75 EndNote Plug-Ins Installer - X

End Note Select Features

[=}-=-] EndNote Plugins for Windows
‘2-| Capture Plugin for Internet Explorer
Cite While You Write for Microsoft Word

q = Will be installed on local hard drive.
=8 Entire feature will be installed on local hard drive.

Search. insert and = Feature will be installed when required.
ir?Stalntly fo_rmat ‘ Entire feature will be unavailable. I
citations with

Cite While You Write™

Cancel
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e Click the Next button on the Ready to Install the Application screen below. If your operating system
requires permission to continue the installation, approve the installation.

75 EndNote Plug-Ins Installer - X

End NOte Ready to Install the Application

Click Next to start updating your system or Cancel to exit.

Q

Search, insert and
instantly format
citations with

Cite While You Write™

el ned> | | Cance

e Whentheinstallation has completed, click the Finish button. You can now begin using the EndNote
online plug-in for direct export.

15 EndNote Plug-Ins Installer - X

EndNote

EndNote Plug-Ins has been successfully
installed.

Q Click the Finish button to exit this installation.

Search, insert and
instantly format
citations with

Cite While You Write™

y

5.3 Using Direct Export Online

Using direct export online works just as it does on the desktop, except that you are directing the references
to your online library; so the steps shown in this booklet in the sections Direct Export from Web of Science
or Direct Export from PubMed apply here, as well. Installing the plug-in for Internet Explorer will also enable
direct export in Microsoft Edge or Google Chrome on Windows.
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5.4 Capturing Multiple References

Capture is not the same thing as direct export, and can work differently for different web sites and
databases. For some sites, it may only allow you to capture a single record, while for other sites a set of
records. Below are examples of differences you might see with different browsers and different databases
for multiple records.

Please remember that the examples given below are only a few of the online sources Capture can be used
with.

5.4.1 Installing the Capture Bookmarklet

Google Chrome, Firefox, and Safari

Thesteps toinstall the Capture bookmarklet are the same for Google Chrome and Firefox on both Windows
and Macintosh, as well as Safari on Macintosh.

e On the Downloads page in EndNote online, locate the Capture Reference bookmarklet on the
screen and drag it to the bookmarks bar (Chrome or Firefox) or favorites bar (Safari).

Capture: Capture Reference

To install the Capture tool, just drag the Capture Reference
button to your Bookmarks bar (also known as "Favorites Bar" or
"Bookmarks Toolbar"). In some browsers, you may need to right-
click and select "Add to Favorites" or "Bookmark This Link."

To use it, browse to a page you like and click the Capture
Reference button in the Bookmarks bar. The Capture Reference
window will open. Follow the instructions in the window.

e A Capture Reference button will appear on the bookmarks bar (Chrome or Firefox) or favorites bar
(Safari).

(3 EndNote X

< C O

=== Apps [ |Capture Reference

If you are synchronizing bookmarks between your Mac desktop and iPad and you have installed the
Capture bookmarklet on your desktop computer, you should see a Capture Reference button appear on
the favorites bar in Safari on the iPad. In general, it will work as it does on the desktop if you are also using
the EndNote iPad app, but we have seen problems using it with sites that require scrolling.

Safari on iPad
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5.4.2 Capture a Set of References from PubMed

e Perform your search in PubMed.

e By default, PubMed shows 20 results per page. Click on the Per page drop-down arrow, shown
below, to show up to 200 records per page. The Capture will be for a single page of references at a
time.

Per page: 20 ~
Items per page

5

10
® 20

50

100

200

e Click the Capture button on the EndNote plug-in’s toolbar for Internet Explorer, or the Capture
Reference bookmarklet button in other browsers. Below are the results you should see.

Results for Capture Button in Internet Explorer

e When the capture is finished, you should see a message that multiple references have been
imported into your Unfiled group. You can continue capturing references one page at a time.
(Please note thatin Internet Exploreryou could also use direct export to export up to 200 references
at a time to either your online or desktop library.)

Results for Capture Bookmarklet in Google Chrome or Firefox on Windows

e When you see the screen below, which may take several moments to appear, select
my.endnote.com to import the page of references to your EndNote online library or EndNote to
import the references to your EndNote desktop library, then click the Capture button.

Go to EndNote Closel[x]

Capture New References

To: |'® my.endnote.com EndNote

Groups: | AI: Corvids

U

L] AI: Parrots

L] Bat: Chiroptera
) Bat: Echolocation

L) |New Group

Y —

View in fi A3 ik English Deutsch
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e Ifyou selected my.endnote.com, you can also select the group to add the references to or you can
create a new group for the references.

e Ifyou selected EndNote, the browser will download the references as shown below.

Go to EndNote Closel[x]

20 references were captured successfully.
Please wait while your request is processed.

Download If the "Download" process does not start automatically, click "Download"

View in i fA 32 Ak English Deutsch HAE o= Portugués Espafiol

e When you see the screen above, if using Chrome look in the status bar at the bottom of the screen,
where you can select the option to Open the file.

Open

Always open files of this type
Show in folder

Cancel

e CaptureToDesktop.ris 7

e Atthis pointyou can follow the direct export instructions found in section 2.3.3.

Copyright © Clarivate Analytics 2018 June 2018



@ The Little EndNote How-To Book Page 69

5.5 Capturing a Single Reference

e The Capture button can also be used to capture information from web sites such as YouTube,
Amazon.com, online newspapers, etc. When looking at a newspaper article, video in YouTube,
book information in Amazon.com, or similar web sites, click the Capture button in Internet Explorer
or the Capture Reference bookmarkletin other browsers to capture the information on the site. You
will see an editable record such as the one below, showing the data EndNote was able to capture.

Go to EndNote Close[x]

a

Capture New Reference

Bibliographic Fields | Optional Fields

my.endnote.com '® EndNote

Groups:

Bibliographic Fields:

Reference Type:

Add or remove
At least one of the fields must be filled out.

Journal Article v

Author: | carly Cassella
Use format Last Name, First name. Enter each name on a new
line.
Title: we Just Got More Compelling Evidence That The Moon Is Loa:
Year: 2018
Journal:
Volume:
Part/Supplement:

e Select the option to save it to my.endnote.com to save it to your online library, with the option to
save it to an existing group or create a new group, or select EndNote to save it to your desktop

library.

Go to EndNote

Close[x]

Capture New Reference

® my.endnote.com

Bibliographic Fields | Optional Fields

EndNote

Groups:

Bibliographic Fields:

Part/Supplement:

b Dot

Reference Type:

Add or remove

At least one of the fields must be filled out.

\ Journal Article v ]

a

Author: Classical Work
: name. Enter each name on a new
Computer Program
Title: Evidence That The Moon Is Loa
Conference Paper
Year:
Conference Proceeding
Journal:
Dataset
Volume:

Dictionary

Issue: | Discussion Forum
Pages: | egited Book
Start Page: o
Electronic Article
Errata:

Electronic Book
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e Edit the reference to add missing information or change the reference type, then click the Save to
button to save the record.
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6 Cite While You Write

EndNote’s Cite While You Write (CWYW) lets you look up references, insert them in your document, format
your bibliography, and edit your citations to include page numbers or other text, all from within your word-
processing document. Below are instructions for using Cite While You Write with Microsoft Word.

6.1 Cite While You Write in Microsoft Word on Windows

6.1.1 Installing the Cite While You Write Tools

When you install EndNote, it will automatically install files into a common program folder, allowing
EndNote and Word to communicate and enabling Cite While You Write (CWYW). In Word for Windows you
will see a tab on the ribbon similar to that shown below. (Note: It is best to close all other programs before
installing EndNote, most especially Word and Outlook. When installing Word and EndNote on a new
computer, always install Word first to enable EndNote to find it and be able to install the Cite While You
Write tools.)

File Home Insert Design Layout References Mailings Review View Developer Help EndNote X9

|,,| EN, Go to EndNote Style: APA 6th - @Categorize References ~ Export to EndNote ~ e
Q B% Edit & Manage Citation(s) [Z} Update Citations and Bibliography [E)instant Formatting is Off ~ Il Manuscript Matcher

C'Itn:'ert R Edit Library Reference(s)  E@ Convert Citations and Bibliography - =Ppreferences
itation ~

Help

Citations Bibliography &~ Tools

Below is information on using the Cite While You Write tools you will need on a day-to-day basis.

6.1.2 Adding Citations to a Document Using Insert Citation
e Click in the top half of the Insert Citation button in Word to open the Find & Insert My References

window.
Eﬁ

Insert
Citation ~
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e Inthe find & Insert My References window that appears, (1) select whether you want to search your
open EndNote desktop libraries or groups shared with you in EndNote online, (2) enter your search
terms, and (3) click the Find button, or press the Enter/Return key, to bring up a set of references
that contain those search terms. The terms can be anywhere in the EndNote record, but all the
terms must be present in the same record.

Pepperberg 2011
Pepperberg 2006
Pepperberg 2001
Pepperberg 2012
Peron 2011
Schloegl 2012
The Alex Foundation 2007
Vick 2010

<

EndNote X9 Find & Insert My References X
| bird grey parrot M Find Search: |Libraries v

Libraries 1
Author ear Title Shared Groups

Avian cognition and al interaction: Fifty years of advances

Cognitive and commurjiative abilities of grey parrots

In search of King Solofllon's ring: Cognitive and communicative studies of grey parrots (Psittacus er
Symbolic communicati®h in the grey parrot

Cooperative problem Qng in African grey parrots (Psittacus erithacus)

Grey parrots use inferehtial reasoning based on acoustic cues alone

Alex the African grey parrot and subject of landmark studies of bird intelligence dies at 31

How do African grey parrots (Psittacus erithacus) perform on a delay of gratification task?

Reference Type:  Journal Article
Record Number: 2313

Alternate Journal: Interact. Stud.

Library: Sample_Library_X9.enl

Type of Article: Editorial Material

Author: Pepperberg, 1. M.

Year: 2011

Title: Avian cognition and social interaction: Fifty years of advances
Journal: Interaction Studies

Volume: 12

Issue: 2

Pages: 195-207

Insert |~ Cancel Help

8 items in list
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o Next, select (highlight) the reference(s) you want to insert. When you select a single reference, you
will see the details for that reference in the bottom part of the window, but details can be shown
for only a single reference. However, you can select multiple references for insertion by holding
down the Control key and clicking on them, then selecting your insertion options from the Insert

list.
EndNote X9 Find & Insert My References X
‘ bird grey parrot v Find Search: |Libraries v
Author Year  Title
Pepperberg 2011 Avian cognition and social interaction: Fifty years of advances
Pepperberg 2006  Cognitive and communicative abilities of grey parrots
Pepperberg 2001  In search of King Solomon's ring: Cognitive and communicative studies of grey parrots (Psittacus er
Pepperberg 2012 Symbolic communication in the grey parrot
Peron 2011 Cooperative problem solving in African grey parrots (Psittacus erithacus)
Schloegl 2012  Grey parrots use inferential reasoning based on acoustic cues alone
The Alex Foundation 2007  Alex the African grey parrot and subject of landmark studies of bird intelligence dies at 31
Vick 2010  How do African grey parrots (Psittacus erithacus) perform on a delay of gratification task?
< >
Reference Type: Book Section N
Record Number: 2336
Author: Pepperberg, Irene M.
Year: 2012
Title: Symbolic communication in the grey parrot
Editor: Vonk, Jennifer
Shackelford, Todd K.
Book Title: The Oxford Handbook of Comparative Evolutionary Psychology
Place Published: New York
Publisher: Oxford University Press
Pages: 297-319 N
Cancel Help
Library: Sample_Library_X9.enl 5
Insert & Display as: Author (Year) -
Insert & Exclude Author
Insert & Exclude Year
Insert in Bibliography Only

e Your references will be inserted in the document and instantly formatted.

6.1.3 Adding Citations to a Document Using Insert Selected Citation(s)

e To select the citations you will insert in the document, return to EndNote by clicking the Go to
EndNote button.

EN, Go to EndNote

e InEndNote, select (highlight) the references you want to insert. You have two choices for how you
insert them in the document.

o Youcaninserttheminthe document from EndNote using the first button of the set shown
below, Insert Citation. (Note this is a different command than the Insert Citation button
within Word, being the equivalent of the Insert Selected Citation(s) command in Word.) This
will insert the references wherever your cursor is located in Word.

e
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o If you would like to check if your cursor is in the correct location and then insert the
references from within Word, in EndNote click on the third button shown in the set below,

Go to Word Processor.

o Ifyou returned to Word to insert the selected citations, click the bottom part of the Insert
Citation button, then select Insert Selected Citation(s) from the drop-down list.

|”Ql
Insert
Citation 'h

Fﬁ Insert Selected Citation(s)

e Your references will be inserted in the document and instantly formatted.

6.1.4 Selecting the EndNote Style for Your Citations and Bibliography

e You can select your preferred style from the drop-down style list as shown below, or select the
Select Another Style option to see the list of EndNote styles available on your computer. (Note that
a typical installation of EndNote only installs a list of popular styles. You can perform a custom
installation of EndNote to install more styles or download them from the EndNote web site. See
section 1.2.1 forinstructions for a custom installation of EndNote.)

‘Annotated I

Select Another Style...
Annotated
|APA 6th

e If you would like more control over the formatting of the citations and bibliography, such as the
ability to change the line spacing or set hyperlinking options between the citations and
bibliography, click the small arrow in the bottom right corner of the Bibliography group to open the
Configure Bibliography window.

Style: APA 6th v @Categorize References ~
LE,! Update Citations and Bibliography lnstant Formatting is Off ~
E'\Convert Citations and Bibliography ~

Bibliography T~
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e Thetwo tabsin the Configure Bibliography window provide options for changing the style, adding,
removing, or formatting hyperlinks between citations and their matches in the bibliography,
adding a centered title above the bibliography, changing the font used for the bibliography, and
more. Select your options, then click the OK button to make your changes. Changing these options
using Word commands would not create permanent changes; you must use the Configure
Bibliography command to permanently change options such as font or line spacing in the

bibliography.

EndNote X9 Configure Bibliography
Format Bibliography  Layout
Format document:  Example.docx
With output style: ~ APA 6th v | | Browse...

Temporary citation delimiters

Left: |{ Right: |}

[JLink in-text citations to references in the bibliography

Underline linked in-text citations

EndNote X9 Configure Bibliography X
Format Bibliography Layout
Font: Size:
Calibri v
Bibliography title:
References Text Format...

Start with bibliography number: | 1

First line indent: | 0.000 in Line spacing:  Single v

Hanging indent: | 0.500 in Space after:

Cance

6.1.5 Editing Citationsin the Document

If you try to edit citations in a document by simply typing the page numbers into a citation or removing an
author’s name from a citation, the change will only be temporary and will disappear with the next update
of the bibliography. Worse than that, you risk corrupting the citation codes, which would prevent EndNote
from updating them and could cause other problems in your document. The safe way to make changes to
the citations is using the Edit & Manage Citation(s) command.

e Click on the citation you want to change, then click the Edit & Manage Citation(s) button.

|Z_’,'~ Edit & Manage Citation(s)
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e Inthe Edit & Manage Citation(s) window there are two tabs in the lower part of the window. The first
tab, Edit Citation (shown below), contains fields where you can add prefix or suffix text to a citation,
as well as page numbers for those styles that require them. There is also a drop-down Formatting
list that provides options to put the author’s name before the citation, exclude an author’s name,
exclude theyear, orshow thereference onlyin the bibliography. (Note: If you are using a style where
page numbers entered in the Pages field do not show, enter page numbers in the Suffix field, which
will always show.)

EndNote X9 Edit & Manage Citations X

Citation - Count  Library

(Laudato, 2010; Pepperberg, 1999)

| B Leudato, 2010 #2334 1 T ) |

1t Pepperberg, 1999 #2298 1 Sample_Library X9 Edit Reference| v ‘

(Bird & Emery, 2009; Holzhaider et al., 2011; von Bayern, Heathcote, Rutz, & Kacelnik, 2009)

4 Bird, 2009 #2318 1 Sample_Library_X9 Edit Reference ~ ‘

4 ¥ Holzhaider, 2011 #2314 1 Sample_Library_X9 Edit Reference ~ ‘
1t von Bayern, 2009 #2316 1 Sample_Library_X9 Edit Reference| v ‘

Edit Citation Reference
Formatting: Default v

Prefix: ‘
Suffix: ‘

Pages: ‘

Tools v | OK | Cancel ‘ Help

Totals: 2 Citation Groups, 5 Citations, 5 References

e Thesecond tab, Reference, shows the details for the selected (highlighted) reference in the top half
of the window.

EndNote X9 Edit & Manage Citations X

Citation - Count  Library

(Laudato, 2010; Pepperberg, 1999)

| B E Leudato, 2010 #2334 1 Sample_Library_X9 |

1+ Pepperberg, 1999 #2298 1 Sample_Library_X9 Edit Reference| »

(Bird & Emery, 2009; Holzhaider et al., 2011; von Bayern, Heathcote, Rutz, & Kacelnik, 2009)

4 Bird, 2009 #2318 1 Sample_Library_X9 [Edit Reference| ~

4 & Holzhaider, 2011 #2314 1 Sample_Library_X9 Edit Reference| |
1+ von Bayern, 2009 #2316 1 Sample_Library_X9 Edit Reference| »

Edit Citation ~Reference

Reference Type: Online Multimedia
Record Number: 2334

Created By: Laudato, Anthony
Year: 2010

Title: Bird grooves to the beat
Series Editor:  Small, David

Series Title: CBS Sunday Morning
Distributor: CBS

Date Accessed: March 15, 2013
Type of Work:  Online Video
Format/Length: 4:49

Keywords: avian intelligence
dance
cockatoo
language
URL: http://www.cbsnews.com/video/watch/?id=6554351n&tag=contentMain;contentBody

Tools ~ Cancel Help

Totals: 2 Citation Groups, 5 Citations, 5 References
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e Along with being able to add text to citations, you can also use the Edit Reference drop-down list
for each reference to add new citations to the grouped citation with the Insert Citation command,
or safely remove citations from a grouped citation with the Remove Citation command. This is the
safest way to remove citations from a document because it safely removes all the hidden coding.
If the coding is not completely removed, it can result in a corrupted citation.

EndNote X9 Edit & Manage Citations X
Citation : Count  Library
(Laudato, 2010; Pepperberg, 1999)

B £ Laudato, 2010 #2334 Sample_Library X9 Edit Reference| ~
1+ Pepperberg, 1999 #2298 1 Sample_Library_X9 Edit Library Reference

(Bird & Emery, 2009; Holzhaider et al., 2011; von Bayern, Heathcote, Rutz, & Kacelnik, 2009) Find Reference Updates...
4 Bird, 2009 #2318 1 Sample_Library_X9 Remove Citation
4+ || Holzhaider, 2011 #2314 1 Sample_Library_X9 Insert Citation
1t von Bayern, 2009 #2316 1 Sample_Library_X9 Update from My Library...
Edit Citation Reference
Formatting:  Default v
Prefix:
Suffix:
Pages:
Tools v Cancel Help
Totals: 2 Citation Groups, 5 Citations, 5 References

6.2 Cite While You Write in Microsoft Word 2016 on Macintosh

6.2.1 Installing the Cite While You Write Tools

When you install EndNote X7.5 or later it will automatically install files allowing EndNote and Word 2016 to
communicate and enabling Cite While You Write (CWYW). In Word 2016 you will see a tab on the ribbon,
similar to that shown below.

Home Insert Design Layout References Mailings Review View EndNote X9

EN, Go to EndNote Style: Annotated 2 4 ) E Tools ¥
7 4 iﬁ Categorize References v
Q E,‘- Edit & Manage Citation(s) L=_,‘~ Update Citations and Bibliography . m Manuscript Matcher
Insert — o — . o ﬁ Instant Formatting is On v —_— Help
Citation Eﬁl' Edit Library Reference(s) F?" Configure Bibliography — Preferences

Below is information on using the Cite While You Write tools you will need on a day-to-day basis.

6.2.2 Adding Citations to a Document Using Insert Citation

e Click the Insert Citation button on the EndNote tab in Word to open the Find & Insert My References

window.
|!!| v
Q

Insert
Citation
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e Inthe Find & Insert My References window that appears, (1) select whether you want to search your
open EndNote desktop libraries or groups shared with you in EndNote online, (2) enter your search
terms, and (3) press the Return key on your keyboard, to bring up a set of references that contain
those search terms.. The terms can be anywhere in the EndNote record, but all the terms must be
presentin the same record.

o EndNote X9 Find & Insert My References
Find Citation: |Q bird grey parrot Ql Searcm
Shared Groups
Author ~ Year Title e
Pepperberg Avian cognition and social interaction: Fifty years of .,1 Jances
Pepperberg 2006 Cognitive and communicative abilities of grey parrots
Pepperberg 2001 In search of King Solomon's ring: Cognitive and communicative st...
Pepperberg 2012 Symbolic communication in the grey parrot
Peron 201 Cooperative problem solving in African grey parrots (Psittacus erit...
Schloegl 2012 Grey parrots use inferential reasoning based on acoustic cues alone
The Alex Found... 2007 Alex the African grey parrot and subject of landmark studies of bir...
Vick 2010 How do African grey parrots (Psittacus erithacus) perform on a de...

Reference Type: Journal Article
Record Number: 2313

Author: Pepperberg, I. M.

Year: 2011

Title: Avian cognition and social interaction: Fifty years of advances
Journal: Interaction Studies
Volume: 12

Issue: 2

Pages: 195-207

Type of Article: Editorial Material
Alternate Journal: Interact. Stud.
ISSN: 1572-0373

? Cancel Insert |+

Library: Sample_Library_X8.enl 8 items in list
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o Next, select (highlight) the reference(s) you want to insert. When you select a single reference, you
will see the details for that reference in the bottom part of the window, but details can be shown
for only a single reference. However, you can select multiple references for insertion by holding
down the Command key and clicking on them, then selecting your insertion options from the Insert

list.
[ ) EndNote X9 Find & Insert My References
Find Citation: = Q_ bird grey parrot €  Search: Libraries
Author ~ Year Title
Pepperberg 201 Avian cognition and social interaction: Fifty years of advances
Pepperberg 2006 Cognitive and communicative abilities of grey parrots
Pepperberg 2001 In search of King Solomon's ring: Cognitive and communicative st...
Pepperberg 2012 Symbolic communication in the grey parrot
Peron 20M Cooperative problem solving in African grey parrots (Psittacus erit...
Schloegl| 2012 Grey parrots use inferential reasoning based on acoustic cues alone
The Alex Found... 2007 Alex the African grey parrot and subject of landmark studies of bir...
Vick 2010 How do African grey parrots (Psittacus erithacus) perform on a de...

Reference Type: Book Section

Record Number: 2336

Author: Pepperberg, Irene M.

Year: 2012

Title: Symbolic communication in the grey parrot
Editor: Vonk, Jennifer

Shackelford, Todd K.

Book Title: The Oxford Handbook of Comparative Evolutionary Psychology
Place Published: New York

Publisher: Oxford University Press

Pages: 297-319

Chapter: 16

? cancel (IR —
Library: Sample_Library_X8.enl Insert & Display as: Author (Year)

Insert & Exclude Author
Insert & Exclude Year
Insert in Bibliography Only

e Your references will be inserted in the document and instantly formatted.

6.2.3 Adding Citations to a Document Using Insert Selected Citation(s)

e To select the citations you will insert in the document, return to EndNote by clicking the Go to
EndNote button.

EN, Go to EndNote

e InEndNote, select (highlight) the references you want to insert. You have two choices for how you
insert them in the document.

o Youcaninserttheminthe document from EndNote using the first button of the set shown
below, Insert Citation. (Note this is a different command than the Insert Citation button
within Word, being the equivalent of the Insert Selected Citation(s) command in Word.) This
will insert the references wherever your cursor is located in Word.

[ 4fe=gien)
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o If you would like to check if your cursor is in the correct location and then insert the
references from within Word, in EndNote click on the third button shown in the set below,

Return to Word Processor.
ﬁ WE

o Ifyou returned to Word to insert the selected citations, click the down arrow on the Insert
Citation button, then select Insert Selected Citation(s) from the drop-down list.

lZ_Ib Insert Citation...

Insert Selected Citation(s)

e Your references will be inserted in the document and instantly formatted.

6.2.4 Selecting the EndNote Style for Your Citations and Bibliography

e You can select your preferred style from the drop-down style list as shown below, or select the
Select Another Style option to see the list of EndNote styles available on your computer. (Note that
a typical installation of EndNote only installs a list of popular styles. You can use the Customizer
under the EndNote menu to install more styles or download them from the EndNote web site.)

g

Select Another Style...
Style: v Annotated
APA 6th

Author-Date

e If you would like more control over the formatting of the citations and bibliography, such as the
ability to change the line spacing or set hyperlinking options between the citations and
bibliography, click the Configure Bibliography button to open the Configure Bibliography window.

Fj'- Configure Bibliography
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e Thetwo tabsin the Configure Bibliography window provide options for changing the style, adding,
removing, or formatting hyperlinks between citations and their matches in the bibliography,
adding a centered title above the bibliography, changing the font used for the bibliography, and
more. Select your options, then click the OK button to make your changes. Changing these options
using Word commands would not cause permanent changes; you must use the Configure
Bibliography command to permanently change options such as font or line spacing in the
bibliography. (Note: it is best not to mark the box to Link in-text citations to references in the
bibliography until you have finished editing the document. If you mark this box, whenever you try
to select a citation, EndNote will jump to the bibliography.)

EndNote X9 Configure Bibliography EndNote X9 Configure Bibliography
Format Bibliography JRENLI Format Bibliography
Font:  Calibri B Size: 1 n
Format document: = Sample_Word.docx B
With output style:  APA 6th Browse... Bibliography title:
References
Temporary citation delimiters Text Format...
Left: |{ Right: }

Start with bibliography number: 1
Link in-text citations to references in the bibliography

First line indent:  0.000 in Line spacing: =~ Single
Hanging indent: 0500 in Space after: v None
1.5 Lines
2 Cancel “ ? Double -

6.2.5 Editing Citations in the Document

If you try to edit citations in a document by simply typing the page numbers into a citation or removing an
author’s name from a citation, the change will only be temporary and will disappear with the next update
of the bibliography. Worse than that, you risk corrupting the citation codes, which would prevent EndNote
from updating them and could cause other problems in your document. The safest way to make changes
to the citations is using the Edit & Manage Citation(s) command.

e Click on the citation you want to change, then click the Edit & Manage Citation(s) button.

|Z_?,I- Edit & Manage Citation(s)
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e Inthe Edit & Manage Citation(s) window there are two tabs in the lower part of the window. The first
tab, Edit Citation (shown below), contains fields where you can add prefix or suffix text to a citation,
as well as page numbers for those styles that require them. There is also a drop-down Format list
that provides options to put the author’s name before the citation, exclude an author’s name,
exclude theyear, orshow thereference onlyin the bibliography. (Note: If you are using a style where
page numbers entered in the Pages field do not show, enter page numbers in the Suffix field, which
will always show.)

o EndNote X9 Edit & Manage Citations

Citation ~ Count Library

¥ (Laudato, 2010; Pepperberg, 1999)
0 ' Laudato, 2010 #2334 1 Sample_Library_X8
4 Pepperberg, 1999 #2298 1 Sample_Library_X8
v (Bird & Emery, 2009; Holzhaider et al., 2011; von Bayern, Heathcote, Rutz, & Kacelnik, 2009)
¥+ 1 Bird, 2009 #2318 1 Sample_Library_X8
¥ 4 Holzhaider, 2011 #2314 1 Sample_Library_X8
4 von Bayern, 2009 #2316 1 Sample_Library_X8

td

Ll

Reference
Format: = Default
Prefix:
Suffix:

Pages:

2 (@

Totals: 2 Citation Groups, 5 Citations, 5 References
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e Thesecond tab, Reference, shows the details for the selected (highlighted) reference in the top half
of the window.

(] EndNote X9 Edit & Manage Citations
Citation A Count Library
¥ (Laudato, 2010; Pepperberg, 1999)
° %’ Laudato, 2010 #2334 1 Sample_Library_X8
4+ Pepperberg, 1999 #2298 1 Sample_Library_X8 £ -3
v (Bird & Emery, 2009; Holzhaider et al., 2011; von Bayern, Heathcote, Rutz, & Kacelnik, 2009)
¥ Bird, 2009 #2318 1 Sample_Library_X8 -3
¥ 4 Holzhaider, 2011 #2314 1 Sample_Library_X8 *
4 von Bayern, 2009 #2316 1 Sample_Library_X8 *
Edit Citation
Reference Type: Online Multimedia
Record Number: 2334
Created By: Laudato, Anthony
Year: 2010
Title: Bird grooves to the beat
Series Editor: Small, David
Series Title: CBS Sunday Morning
Distributor: CBS
2 (% Cancel
Totals: 2 Citation Groups, 5 Citations, 5 References

e Along with being able to add text, remove the author name, or remove the year, you can also use
the drop-down list for each reference to add new citations to a grouped citation with the Insert
Citation command, or safely remove citations from a grouped citation with the Remove Citation
command. This is the safest way to remove citations from a document because it safely removes
all the hidden coding. If the coding is not completely removed, it can result in a corrupted citation.

@ EndNote X9 Edit & Manage Citations
Citation A Count Library
¥ (Laudato, 2010; Pepperberg, 1999)
o %) Laudato, 2010 #2334 1 Sample_Library_X8
4 Pepperberg, 1999 #2298 1 Sample_Library_X8 | Edit Library Reference
v (Bird & Emery, 2009; Holzhaider et al., 2011; von Bayern, Heathcote, Rutz, & Kacelnik, 200 Viton
+ Bird, 2009 #2318 1 Sample_Library_X8 | Update From My Library...
¥+ '+ Holzhaider, 2011 #2314 1 Sample_Library_X8 )
4 von Bayern, 2009 #2316 1 Sample_Library_X8 *

Edit Citation

Reference Type: Online Multimedia
Record Number: 2334

Created By: Laudato, Anthony
Year: 2010

Title: Bird grooves to the beat
Series Editor: Small, David

Series Title: CBS Sunday Morning
Distributor: CBS

) &)

Totals: 2 Citation Groups, 5 Citations, 5 References
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7 Collaboration: Sharing EndNote References

An EndNote library is not a single file. It is a set of files, many of them frequently updated as you work, and
these files must be updated in a strict sequence by EndNote to avoid corruption of the library. This can
cause difficulties when sharing libraries because only EndNote can properly control the sequence for
updating and saving of data in the library, and outside synchronization or file management services can
actually damage EndNote libraries. This section covers some of the methods to avoid, and then talks about
safer methods of sharing references or complete libraries.

7.1 How Not to Share an EndNote Library

7.1.1 EndNote Libraries on “Cloud” Services

Never store an EndNote working library on any cloud service for sharing, or even just for your own use on
multiple computers. This will eventually lead to library corruption because of the way the cloud services
synchronize files over the Internet. Such unusable cloud services would include, but are not limited to—

e iCloud
e Amazon Cloud
e Box
e Dropbox
e Google Drive
e SharePoint
e OneDrive
e SugarSync
Also, never store a working library on a flash drive.

The reason these methods are inadvisable is that when you are working in EndNote, it is saving data to
multiple files, and the data must be saved in a set sequence, as described above. When cloud services
transfer that data, they may change the sequence of file saves. This eventually leads to library corruption.
The library may appear to be fine for days, weeks, or even months, but will eventually be corrupted.

7.1.2 EndNote Libraries in “Optimized” iCloud Storage

With Mac OS X 10.12 (Sierra), Apple added options to “optimize” storage space on Apple computers by
storingdatainiCloud automatically and removing some of that data from the local hard drive. If you choose
the option to “Store in iCloud” as described in Apple support article https://support.apple.com/en-
us/ht206996, even libraries stored in your Documents folder will be kept in iCloud. This puts EndNote
libraries in your documents folder at risk of corruption.
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7.1.3 EndNote Libraries on Network Servers

EndNote libraries with read-write access should not be stored on network drives. We have seen corruption
problems with libraries on network drives as well as general performance issues. Ideally, the library should
be kept on the owner’s computer. If you must keep a library with read-write access on a network drive, we
suggest you make frequent backups of the library using the File=>Compressed Library command for
libraries smaller than 5G or the File=> Save A Copy command for larger libraries.

If your company requires you to save data to a network drive, talk to your IT department about saving your
EndNote libraries on your computer's hard drive instead. You can refer them to this chapter, or to the
EndNote Library Safety section on the For Administrators page of the EndNote LibGuide.

7.1.4 Sending the .enl File for a Library When Sharing a Library

Every EndNote library is made up of two parts: the .enl file and the .data folder, as seen below.

| ¥ s | C\Users\Public\Documents\EndNote\Examples - a X
“ Home Share View A o
= \ (- D -
» u d Moveto~ | ¢ Delete ~ B ’\/ FH select all
\ v — Select none
Pinto Quick Copy  Paste Copy to ~ ¥ Renz New Properties .
s [ opyto 13 (e ol - @ = Invert selection
Clipboard Organize New Open Select
<« v 4 < Public Documents > EndNote > Examples v U  Search Examples R
[J Name Date modified Type Size
Sample_Library_X9.Data 6/15/2018 10:49 A File folder
j Sample_Library_X9.enl 6/18/2018 9:54 AM  EndNote Library 116 KB
2 items E —

It may be helpful to think of the .enl file as just the interface file for working with the contents of the .data
folder, where all the real data is kept. When you open a .enl file, EndNote searches for the matching .data
folder and refreshes the screen with the latest information in a sort of “snapshot.” If the .data folder is
removed, EndNote will create a new one with data to match the last “snapshot” because it must have a
.data folder to work. However, that new .data folder would not contain any of the attachments, group
structure, or term lists from the original library; it would contain only the reference data. If you send
somebody the .enl file only, they will receive only a portion of the library.

So how can you share EndNote references safely?

7.2 Sharing Full EndNote Libraries

EndNote X7.2 introduced two much-requested features to EndNote:
1. Unlimited attachment space in EndNote online.

2. Fulllibrary sharing for up to fifteen people, including the library owner. This was expanded to up to
101 people, including the owner, in EndNote X8.
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7.2.1 Unlimited Attachment Space in EndNote Online

EndNote X8 or X9 users can store an unlimited number of files, of any type, in EndNote online — PDFs, Word
documents, PowerPoint presentations, even audio or video files — and through EndNote online those
attachments can sync with up to three computers per user (for a single-user license of EndNote, site
licenses may have restrictions on outside installations of the software).

Please note that EndNote basic users will still be limited to 2 gigabytes of attachment space.

7.2.2 Full Library Sharing

The Basics

Prior to EndNote X7.2, there was no way for users to share simultaneous access to a complete EndNote
library with full read-write permissions and attachments. Full libraries could be shared on a network server
with read-only access for simultaneous use, but only the owner could make changes (and those changes
must be made on the owner's computer, with a read-only copy put on the network), or groups could be
shared through EndNote online, but without attachment sharing. Plus, to share a group online requires the
sharer to know the email address for the “sharee’s” EndNote online account. Users of EndNote X7.2 or later
can share their library, with simultaneous access to all references and attachments, with other users of
EndNote X7.2 or later. The basic requirements and information for sharing are—

e All users must be using EndNote X7.2 or later. If using EndNote X7, users must have first
synchronized their desktop and online libraries before January 1, 2018.

e EndNote X8 or X9 users can share a library with up to 100 people; EndNote X7 users can share a
library with up to fourteen other people.

e Allusers must sync their EndNote desktop and online libraries. The sharing process works through
EndNote Sync.

e Alibrary owner cansynconly one EndNote library, so only one library can be shared with others or
synced to the owner’s other computers or iPad.

e Although a library owner is limited in how many users they can share a library with, an unlimited
number of libraries can be shared with a sharee.

e Because all references and groups are synced to all recipients, with attachments, the library will
take up as much space on the recipient’s computer as it does on the owner’s computer and can be
used off-line. However, the library can only be accessed through the File=>Open Shared Library
command in EndNote.

e With EndNote X8, sharees have full access to the library. This means they can add, change, or delete
references and attachments. With EndNote X9, the library owner can restrict access to read-only or
permit full read-write access individually. We suggest the owner make frequent backups of their
library using the File=>Compressed Library command under any circumstances, but especially if
they are sharing their library with read-write permissions.

! The word “sharee” will be used throughout this section to designate the person a library is shared with.
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How to Share a Library

In your synced library, click the Share Library button.

Sl

If you have not already synced your EndNote desktop and online libraries, click the Sync button to
sync for the first time. (Note that you may be asked if you want to create a compressed library as a
backup if it is the first time the library has been synced on that computer. We strongly suggest
making a backup before the first sync. See section 5.1 for more details on syncing an EndNote

library for the first time.)

O

Sync button for Windows:

Share Library button for Windows:

Share Library button for Macintosh:

Sync button for Macintosh:

Enter the email address of the person you want to invite to the shared library, then click the Invite
button. The email address does not need to be the one the invitee/sharee uses for their EndNote
online account. Note the option to set either Read & Write or Ready Only permissions for each

person you share the library with.

EN, Sharing X
lFind People ‘
Sharing with - Permission Status
EndNote Ubiquitous Read Only Member B o3

Invite More People

Enter email addresses separated by commas

endnote.anywhere@icloud.com

Permission: |Read & Write v
Read & Write
Add a messgRead Onl

EndNote Training

Here is an invitation to share my EndNote library.

Close

You are sharing your library with 1 people out of a possible 100.
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e Theinvitee’s name will be added to the list at the top of the dialog with a Pending status to show
they have not yet accepted the invitation. If you want to send a reminder of the invitation or remove
them from the list, you can do that at any time. You can also change the permissions status of any

member of the sharing group at any time.

You are sharing your library with 2 people out of a possible 100.

EN, Sharing X
‘Find People ‘
Sharing with - Permission Status
EndNote Ubiquitous Read Only Member X
endnote.anywhere@icloud.com Read & Write Pending
Remove
Remind
Read Only
v/ Read & Write
Invite More People
Enter email addresses separated by commas
Permission: Read & Write v
Add a message: (optional)
Invite
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e The invitee will receive an email inviting them to the shared library. They must click the Accept
button in the email to accept the invitation.

e The invitee will be directed to the page below, where they must logon to the EndNote online
account they sync through. If they do not have an EndNote online account, they can create one

here.

Sign In with your EndNote account

Email

Password

Forgot your EndNote password?

To accept this invitation, sign in using the same credentials you use when accessing EndNote online or syncing your desktop
library, or create a new account. To access this shared library you must have EndNote X7.2 or later installed.

Create an EndNote account B

First Name *

Last Name *

Email *

e The invitee will receive a notification that they are ready to access the shared library, with
information on which versions of EndNote they must be using to open the shared library.

e Toopen alibrary that has been shared with you in EndNote, select File>Open Shared Library.

Open Recent

EN, EndNote X9

File Edit References Groups Tools Window Help
New...
Open Library... Ctrl+O
Open Shared Library... Ctrtl+Shift+O

>

e You will see a list of all the libraries that have been shared with you. Select the shared library you

want to open and click the Open button.

Select a Shared Library

Owner

~

endnote.anywhere@icloud.com

ﬁ ‘ Cancel

Copyright © Clarivate Analytics 2018

June 2018




@ The Little EndNote How-To Book Page 90

e The library will open, looking much like any other EndNote library. Note, however, that the name
ofthe library will show the EndNote online account name of the owner and the Share Library button
will be unavailable. You cannot share a library that you do not own with others, only the owner of
alibrary canshareit.

£, endnote.anywhere@icloud.com I

O0® APA 6th

o e

BHEQELR B BB O[L]% - @ s

Q A Hide Search Panel

‘Other Sushi Reference... (1)

@ Henke, Christine; Stri...

@ Hoel, Sunniva; Mehli,..

Selective expression of sense and antisense ...
Assessment of Microbiological Quality of Re...

Retrovirology
Journal of Food Protecti

United States of America

Volume

My Library Search Options » Search Whole Library | [Match Case [JMatch Words | Reference |Preview % Bird-2009-Insightful prot @ 4 b %
All References (82) N "
Duplicate References ®2) Author v | Contains v [ = - . Reference Type: Journal Article - {(EI v
@SY"C Status... ® @ Author Year  Title Journal ~ |Rating
D Recently Added Bird, C. D, Emery, N. J. Insightful problem solving and creative tool ... Proceedings of the Nati... *k. . .
E_jUnfiIed ©) Bolkvadze, Tamuna; R.. 2015  Epileptogenesis after traumatic brain injury i... Epilepsy & Behavior :“;“Z’D
@Trash © @ Cao, Xiaolong; He, Ya.. 2015  Sequence conservation, phylogenetic relatio... Insect Biochemistry and ... E:;e‘ -NVJ
e Chargin, Amanda; Yin.. 2015  Identification and Characterization of HIV-1 ... Journal of Clinical Micro... N2
= Sushi Dupouy-Camet, J; To... Incidence of anisakidosis in France. Retrospe... Bulletin Epidemiologiqu... Year
R Al Sushi 82) @ Englund, Emelie; Reit.. 2015  The human complement inhibitor Sushi Do... Bmc Cancer 2009
# Book Sections ) @ Faste, Christiane Kru.. 2014  Detection of Proteins from the Fish Parasite ... Food Analytical Methods Title ‘
Fresia, F. 2015 Inspired by the world of luxury Food Service Europe an... Insightful problem solving and creative tool modification by
3§ Books U] @ Gao, Zhenyuan; Zhan... 2015 SRPX2 promotes cell migration and invasion... International Journal of ... captive nontool-using rooks
¥ Data Sets (31 @ Gargett, Caroline E; S.. 2016  Endometrial stem/progenitor cells: the first .. Human Reproduction U.. Journal
$# Journal Articles (46) Giusti, Alice; Castiglie.. 2016 A Conventional Multiplex PCR Assay for the ... Journal of Agricultural a... Proceedings of the National Academy of Sciences of the

R patents @ @ Inomata, Naoko; Nag.. 2015  Food allergy preceded by contact urticaria d... Allergology International 106
3 sushi: 2015 (64) @ Irie, Masahito; Yoshik.. 2015  Cognitive Function Related to the Sirh11/Zc... Plos Genetics Part/Supplement
B Sushi: 2016 (14) @ \wata, Kentaro; Fukuc.. 2015 s the Quality of Sushi Ruined by Freezing R... Clinical Infectious Diseas
= My Groups Jenny, Lorenz; Lin, Zh... 2015 The B-subunit of coagulation factor Xl doe... Molecular Inmunology Issue
@ Kim, Peter S; Kwilas, .. 2016  IL-15 superagonist/IL-15R alpha Sushi-Fc fus.. Oncotarget 25
2 sushi Domains @ | @ Lalanne, Nicolas; Kra.. 2015 Development and validation of a numerical .. Quantitative Infrared Th... | pages
2 Sushi-Math (0] @ Liebler, Stefan 2015 Neutral Higgs production at proton colliders... European Physical Journ... 10370-5
= Find Full Text . Lindell, C. 2015  Experience Mariano's Candy Industry , Y start Page .

Showing 82 of 82 references.

@layoul -

e Thenexttimethe owner of the library looks at the list of people she has shared the library with, she
will see you named as a Member of the group sharing the library instead of as Pending.

7.3 Share Groups in EndNote Online

If you do not want to share attachments, need to share references with people using older versions of
EndNote or EndNote basic, or need to share with more than 100 others, you can share groups through
EndNote online.

With this method of sharing references, the owner of the references puts them in a shared EndNote online
group. This method allows large numbers of users to be given access to the same set of references for
collaborative work. At the same time, if groups are created for specific projects, it also allows the owner to
limit shared access to only the references for a project instead of the entire library.

Please note the following restrictions.

e Thismethod allows sharing of the EndNote desktop/online record data, but does not allow sharing
of attachments, even within your own organization. However, you can share links to documents
stored online. So, if you have a copy of a document in a SharePoint or DropBox folder, you can
share a link to the external copy of the document using the URL field.

e Groupscanonly be shared with other EndNote online or basic users, and you will need to know the
email addresses used as account names by such users to share references with them.

Note: Screenshots below show Windows examples, but the features will work the same way on Macintosh.
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7.3.1 Creating an EndNote Online Library

Please see section 5 for information on setting up your EndNote online library if you have not done so
already.

7.3.2 Share Your Group in EndNote Online

e Select Manage My Groups on the Organize tab in EndNote online to see a screen like that below.

My References Collect Organize Format Match Options

Manage My Groups | Others' Groups Find Duplic

Manage My Groups

My Groups# LUl (0] Share
References
Chiroptera 22 [ Manage Sharing Rename Delete
&4 Corvids 19 ¥ Manage Sharing Rename Delete
Echolocation 6 [ Manage Sharing Rename Delete
Parrots 24 O Manage Sharing Rename Delete

e Mark the Share box for the group you want to share, as shown above. You will see an icon with two
people appear to the left of any shared group.

e Click the Manage Sharing button for your shared group to begin sharing it with others.
e Click the Start sharing this group link.

My References Collect

Manage Sharing for 'Corvids'

0 E-mail Addresses

Start sharing this group.
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e You will see the Window below.

Add E-mail Addresses to 'Corvids’

Enter e-mail addresses. Use the Enter or Return key to separate addresses.

|endnote.anywhere@1cloud.comI
L

- OR -

Select a text file with e-mail addresses separated by commas.

Choose File |No file chosen

I Read only '® Read & Write

Note: Attachments are not shared, regardless of access privileges.

Apply

Close window.

View in faitkrh 3 Bk English Deutsch H Al ot=0] Portugués Espafiol

e Add the email address(es) for those you want to share the group with, with each email address on
a separate line. This must be the email address they are using for their own EndNote online/basic
account. You cannot share a group with somebody who is not using EndNote online/basic.

e Select the access rights you want to give this person.

o Read only access will allow them to view your references, copy your references into their
own EndNote online library, or use your references in Microsoft Word, but it will not allow
them to edit your references.

o Read & Write access will allow them to view your references, copy your references into their
own EndNote online library, or use your references in Microsoft Word, and it will also allow
them to edit your references, add new references, and delete your references. Changes
made to your references by others with Read & Write access will also be synchronized back
to your EndNote desktop library if you are synchronizing your libraries.

e Click on the Apply button to save the options, then the Close window link.
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e Youshould now see something like the screen below, showing who you have shared the group with
and what level of access you have given them. You can change the level of access or stop sharing
the group with them at any time.

Manage Sharing for 'Corvids'

1 E-mail Address

E-mail Address 4 Read only Read & Write
endnote.anywhere@icloud.com D Edit

Add More

Note: Attachments are not shared, regardless of access privileges.

Delete

Delete All

7.3.3 Share a Group through EndNote
Thisis a new feature in EndNote X9 and requires syncing your EndNote library first.

e Select the custom group you want to share. Only custom groups can be shared, smart groups,
combination groups, and group sets cannot be shared.

[=/~ Avian Intelligence

@ Avian Cognition 31)
S Corvids (19)
.Corvids & Parrots (6)

Parrots )

e Select Share Group from the Groups menu.

Groups h

Create Group

Create Smart Group
Create From Groups...
Rename Group

Edit Group...

Delete Group

Share Group...h
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e You will need to know the email address the person you are sharing with uses for their EndNote
online account. 1) Enter the email address for the EndNote online account you are sharing the
group with, 2) choose which level of permission you want to give your collaborator, 3) add a private
message, if you wish, and 4) click the Invite button to add your collaborator to your shared group.

EN, Sharing Group Parrots X

‘Find People ‘

Sharing with Permission

Invite More People

Enter email addresses separated by commas

endnote.ubiquitous@icloud.com h a

Permission: |Read & Write v 9
Read & Write
Add a messaRead Only
I'm sharing my EndNote online group about Parrots with you. h 6

EndNote Training

e S
Close

A
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e Aftersending theinvitation, the window below 1) shows the shared group name, 2) shows all those

the group has been shared with, 3) allows the owner to change the permissions for anyone the
group is shared with, remove them from the group, or remind them to accept the invitation if they
are still pending. When finished, 4) click the Close button to close the windows.

EN, Sharing Group Parrots | 0

|Find People

Sharing with -
endnote.ubiquitous@icloud.com

Permission 3
Read & Write

Remind

Read Only
v/ Read & Write

Invite More People

Enter email addresses separated by commas

Permission: Read & Write v

Add a message: (optional)

Invite

O =P |

A
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7.3.4 What the User You Shared Your Group with Will See in EndNote Online

e Theuseryou shared your group with will see your group show up under a Groups Shared by Others
heading in their EndNote online library. The icon of two people with a pencil you see below will
only show when they have been given Read & Write access to the group.

My References

All My References (82)
[Unfiled] (0)
Quick List (0)

Trash (0)

¥ My Groups
All Sushi (82) 2%
Sushi Domains (7) 2%
Sushi-Math (1) 2%

Groups Shared by Others
Corvids (19) &8

e [Ifthe user the group was shared with selects Others’ Groups from their Organize tab, they will see
the screen below. Here they can see the EndNote online account owner of the group and can set if
the group will be shown on the My References tab or used in Microsoft Word with Cite While You
Write.

My References Collect Organize Format Match Options Downloads

Manage My Groups Others’ Groups Find Duplicates Manage Attachments

Others' Groups

Use for . Number of
Access | Show Cite While You Write Groups Others Share with Me R . Oowner
2 ] Corvids 19 endnote.training@outlook.com

e Notethat groups and references that others share with you are not actually part of your library and
will not sync to your EndNote library on the desktop.
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7.3.5 What the User You Shared Your Group with Will See in EndNote

e The person the group was shared with will see it appear under Groups Shared by Others in EndNote
X9 or later. The references will not appear on the desktop but clicking on a group in the list will
activate a shortcut to EndNote online.

2 All References (67)
¥, Imported References (67)
(D Sync Status...
£D Recently Added 67)
Unfiled (29)
Tif Trash ©)
(= Avian Intelligence
%F Computing ©)
¥ Corvids (20)
% Evolution (37)
¥ Parrots (16)
% Problem Solving (3)
= My Groups

(= Find Full Text

- Groups Shared by Others

E_} endnote.training@outlock.com, ...

7.4 Put a Read-Only EndNote Library on a Network Drive

If your group needs to share access to attachments as well as reference data, but for some reason cannot
use EndNote Sync, needs to share attachments with more than 100 others, or is using a version of EndNote
previous to EndNote X7, another option is to put a read-only copy of the library on a network drive. The
library will need to be read-only because only one person at a time can access an EndNote library with
read-write access, while an unlimited number of people can access a read-only library at the same time,
and because read-write libraries kept on a network drive are prone to corruption. This means one person
should be in charge of the master library and keep it on their own computer, then periodically put a read-
only copy of the library on the network drive.

Your network administrator can set up folders on network drives with security settings to allow only one
person to add files while everybody else has read-only access. If you can enlist your network administrator’s
help, this is best. Please note that you should not put a read-write copy of a library on a network drive for
two reasons—

1. Only one person at a time would be able to use the library.

2. Thereis arisk of corrupting the library.
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o When you open aread-only library, you will see a screen like the one below. Click the OK button to
open the library. You will be able to use the library with Cite While You Write, searchit, print from it,
and do anything except change it.

EndNote X

The file "Sample_Library_X9.enl" is locked or is on a locked volume.
No changes will be saved.

OK

e Thesuggested “best method” for putting your read-only copy on the network drive is to first make
a compressed library with all records and all attachments on your hard drive, then copy that file to
the network location and open it there. It will uncompress to create the .enl file and .data folder
necessary to work in the library.

7.5 Send a Compressed Library

If you are unable to use the methods described above, you could instead send a compressed library
through email, burn it to disk, or put it on a flash drive or on a shared cloud service. This method allows you
to control exactly references are included, and whether or not attachments are included.

The disadvantage of this method is that users are not working with the same copy of the library. Each
person would have their own copy of the library and changes to references could be made in each copy
differently.

e With the EndNote library you want to compress open in EndNote, select Compressed Library from
the File menu. You should then see the screen below, which you saw earlier in this chapter, but
because you are not making a complete backup copy this time you can limit the references to only
those you want to send.

Compressed Library (.enlx) X
(® Create (® With File Attachments
(O Create & E-mail (O Without File Attachments
(® All References in Library: Sample_Library_X9.enl

(O Selected Reference(s)

(O All References in Group/Group Set:  Avian Intelligence

Next Cancel
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e Select the Create option to create a compressed library you can save on your computer and then
attach to an email. The Create & E-mail option will work with most MAPI-compliant email programs,
but may not work with all email programs. It will not work with web email programs such as Gmail.

e Select the With File Attachments option to include all attachments for the references you are
sending, not just the PDFs. Select Without File Attachments to make the file smaller and to remove
PDFs and other attachments.

e The bottom part of the window gives you options on which references will be included in the
compressed file.

o All References in Library would include all the references in your library. This option is also
an excellent way to create backup copies of your libraries. Please note that you may be
unable to attach very large libraries with attachments to emails or even put them on disks
because of operating system limitations on the size of zipped/compressed files.

o Selected Reference(s) will include only the references you have highlighted (selected) in the
library.

o All References in Group/Group Set will allow you to include only the references in a specific
group or group set.

e Clickthe Next button to see the screen below, where you can choose where the compressed library
will be saved and rename it, if desired. In the example below the date has been added to the library
name to help identify it later. Please note, again, that a compressed library can be saved to a cloud-
syncing folder but it cannot be opened and safely worked with in the cloud-syncing folder. The
library would need to be moved out of the cloud-syncing folder to be able to open it and work with
it safely. See section 7.1.1 for more information.

EN, Save Compressed Library (.enlx) X
1A = > ThisPC » Documents v O  Search Documents »p

Organize ~ New folder = - (?)
~  Name Date modified Type °

st Quick access ) ' . .

MathMagic Equation Editor 1/31/2018 2:17 PM  File fol,

mDesktop 4 OneNote Notebooks 9/28/2017 12:22 P File fol
4 Downloads ' , S
File name: | eIl CHEIT T CRT MY v
Save as type: EndNote Compressed Library (*.enlx) v

A Hide Folders Cancel

e Click the Save button to save your compressed library. Please note that a large library with many
attachments may take a long time to compress. The compressed library will have a .enlx extension.

e The compressed library can now be attached to an email, burned to disk, or put on a network or
cloud drive for distribution.
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o When the recipient wants to use the library, they will need to place it on their computer in its
working location, then select Open—=>QOpen Library from the File menu in EndNote and select the
compressed library file as the file they wish to open. When the file uncompresses it will become a
.enlfile and .data folder.

e Note that recipients of the compressed library will see all the groups and group sets in the library
but only the references you choose to include.

7.6 The Traveling Library

7.6.1 Using the Traveling Library to Create Bibliographies in Shared Documents

If you need only to create a Word document with references from multiple libraries, and do not need to
share the actual data in the library or attachments, you can use the traveling library. This feature is only
available in Microsoft Word.

Whenever you insert an EndNote citation in a Word document, you are inserting a copy of the bibliographic
data for that citation in the field code for the citation. That data becomes part of the paper; when an
EndNote-using colleague works on that paper, they don’t need a copy of your library because all your
citation data is embedded in the paper’s traveling library.

e Here’san example of a simple citation and bibliography entry from a sample Word document.

Text.(Pepperberg, 2011)|

Pepperberg, I. M. (2011). Avian cognition and social interaction: Fifty years of
advances. Interaction Studies, 12(2), 195-207. doi:10.1075/is.12.2.01pep
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e However, that citation came from EndNote, so it has the data seen below “traveling” in the citation
and able to be used by any EndNote user editing the paper. This data is usually invisible to the
reader, but accessible to EndNote.

Text.{ ADDIN EN.CITE
<EndNote><Cite><Author>Pepperberg</Author><Year>2011</Year><RecNum>2313</RecNum
><DisplayText>(Pepperberg, 2011)</DisplayText><record><rec-number>2313</rec-
number><foreign-keys><key app="EN" db-id="50wxdpzd9vd5r7e9t5b595djrfpttrxw9avp"
timestamp="1363371157">2313</key></foreign-keys><ref-type name="Journal
Article">17</ref-type><contributors><authors><author>Pepperberg, I.
M.</author></authors></contributors><auth-address>[Pepperberg, Irene M.] Harvard Univ,
Dept Psychol, Cambridge, MA 02138 USA. [Pepperberg, Irene M.] Brandeis Univ, Waltham, MA
02254 USA.&#xD;Pepperberg, IM (reprint author), Harvard Univ, Dept Psychol, William James
Hall,33 Kirkland St, Cambridge, MA 02138 USA.&#xD;impepper@media.mit.edu</auth-
address><titles><title>Avian cognition and social interaction: Fifty years of
advances</title><secondary-title>Interaction Studies</secondary-title><alt-title>Interact.
Stud.</alt-title></titles><periodical><full-title>Interaction Studies</full-title><abbr-1>Interact.
Stud.</abbr-1><abbr-2>Interact Stud</abbr-2></periodical><alt-periodical><full-
title>Interaction Studies</full-title><abbr-1>Interact. Stud.</abbr-1><abbr-2>Interact
Stud</abbr-2></alt-periodical><pages>195-
207</pages><volume>12</volume><number>2</number><keywords><keyword>avian
cognition</keyword><keyword>avian social learning</keyword><keyword>avian observational
learning</keyword><keyword>avian communication</keyword><keyword>parrots psittacus-
erithacus</keyword><keyword>white-crowned sparrow</keyword><keyword>african grey
parrot</keyword><keyword>song development</keyword><keyword>videotaped
instruction</keyword><keyword>intelligence</keyword><keyword>budgerigars</keyword><k
eyword>information</keyword><keyword>context</keyword><keyword>pigeon</keyword></
keywords><dates><year>2011</year></dates><isbn>1572-0373</isbn><accession-
num>W0S:000295010300001</accession-num><work-type>Editorial Material</work-
type><urls></urls><electronic-resource-num>10.1075/is.12.2.01pep</electronic-resource-
num></record></Cite></EndNote>}

e Below is the same reference, but reformatted with the Vancouver style instead of the APA style.
That’s not anything special for EndNote. However, this citation and bibliography were formatted
with no libraries open in EndNote! That means the only information EndNote had to work with was
the data available in the traveling library.

Text.(1)

1. Pepperberg IM. Avian cognition and social interaction: Fifty years of
advances. Interact Stud. 2011;12(2):195-207.
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e Thismeansyou can send a copy of your paper to a colleague using EndNote, and they do not need
a copy of your library. They can add citations from their own EndNote library, and EndNote will
merge your citations and theirs together to create a single bibliography.

7.6.2 Exporting the Traveling Library
Datain a traveling library can be extracted and put in your own EndNote library.

e On the Cite While You Write tab in Word for Windows, click Export to EndNote in the Tools group,
then select Export Traveling Library from the drop-down list. On Macintosh, select Export Traveling
Library from the Tools drop-down.

EndNote
‘ Tools

Convert to Unformatted Citations

EndNote X9 Convert to Plain Text

Export to EndNote ~ ‘ ‘
Export Traveling Library Export Traveling Library

Windows Macintosh (Word 2016)

e Select the EndNote library to import the references to or create a new library. EndNote will filter
out duplicate references that came from the library you select.

Export Traveling Library X Export Traveling Library
Export Lib to:
R ey & Export Library to:
IE @ n existing EndNote library: ﬁl © An existing EndNote library:
Sample_Library_X9 v Browse... Sample_Library_X8 Browse...
= |  Anew EndNote lib
-— new EndNote librar
E (O A new EndNote library J
Windows Macintosh
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e For large documents with many references, it may take some time for all the references to be
exported, so be patient. EndNote will show a confirmation message when the export is complete,
as shown below.

EndNote X9 X

” Export complete.
Export complete. E N

Windows Macintosh (Word 2016)

e In the Word document, use the Update Citations and Bibliography command to update the
citations in the paper from the new records in the open EndNote library.

LE} Update Citations and Bibliography |.=_,' Update Citations and Bibliography
Windows Macintosh (Word 2016)

The method of collaboration you decide to use will depend on your situation, but hopefully this overview
will help you decide which method is best for you.
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7.7 Summary Comparison of Sharing Methods

> o
[V} [J] - -

5 8 E |52t

85 83 v e )

- Cc > C O 2 ¢ %

g S 2% g

s® | o%2 | 822 | 852

soc | 28¢ | 882 | 885
Features BER | VSO | BOw® | B»OT
Can share all references and groups in library Y Y Y Y
Can share attachments Y N Y Y
All members of sharing community can edit them Y! \& N \&
All changes automatically available to all members of the sharing community Y Y N® N
Maximum number of members in sharing community (EndNote X9) 101 NA* NA* NA*
Library owner can set read-write or read-only access rights for other members of the community Y Y N N
Shared library resides on customer’s server N N Y NA
Shared library resides on EndNote online server Y Y N NA
All members of the community working with the same set of references Y Y N N

t1f owner has given read-write permission.
2 Everyone would have separate copies of the library and could only edit their own copy.

3 Changes to the library could only be made by the owner. Others in the sharing community would only see changes after the owner uploads them to the copy on

the server.
“No set limit
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8 Using the Label Field as a Custom Identifica-
tion Number

The EndNote record number is not a permanent identification number and can change when using
EndNote Sync, if a record is copied into a new library, or even if a record is cut and then pasted back into
the same library. If you prefer an unchanging field to identify a record in both your library and for Cite While
You Write, consider using the Label field in EndNote.

In your original library, you can copy the record number to the Label field for selected references. It is best
to assign all Label field numbers in the same copy of the library, to be sure the number will always be
unique. Remember that the new Label number may not match the record numberin all copies of the library.

8.1 Set the Label Field to Show in the Library Display

Setting the Label field to show in the library display will allow you to easily see which records do not have
text in the Label field, to avoid copying the record number for a record that already has data in that field.

e Openthe EndNote preferences by selecting Edit, then Preferences on Windows or EndNote Xx, then
Preferences on Macintosh.

Windows Macintosh

Edit h EndNote X9

Undo Ctrl+Z

ST O O e e o L o

Counnection Fies >

Preferences...h

o Click Display Fields at the left, then select the Label field from the drop-down list for the column
you want to assign to the Label field. In this example column 1 is selected.

EndNote Preferences X
Change Case o
Display Fields Fields to display in the library window
Display Fonts Position Field ading
Duplicates Column  |Read/Unread Status v
Find Full Text Reviewed Item ~
Folder Locations Column  |Custom 1
Formatting Custom 2
Custom 3

Libraries Column |5 istom 4 Author
PDF Handli Custom 5

anding Column  |Custom 6 Year
Read / Unread Custom 7
Reference Types Column Custom 8 Title
Sorting Accession N er
Spell Check Column Call Number Rating
sync Column izywords Journal

|__-Temporary Citations stract
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e Formyexample I have chosen to show both the Label field and the Record Number field, so that |
can easily compare the two in my library display. Note that | have also edited the heading for the
Record Number field to shorten “Record Number” to “Record #,” to reduce the column width
necessary to show the heading. Click the OK button to close and save the changes on Windows. On
Macintosh, click the Save button, then close the window. (Only Windows illustrations shown

below.)

EndNote Preferences X
Change Case
Display Fields Fields to display in the library window
Display Fonts Position Field Heading
Duplicates Column | Label v [Label
Find Full Text
Folder Locations Column ‘Record Number v IRecord #
Formatting
Libraries Column ‘Author v | |Author

@DeHapdligd e o ol e o o e lF S -

EndNote Defaults ‘ Revert Panel # Cancel Apply

e You should now see a screen showing the Label field, as in the example below. This will allow you
to easily select records that do not have a number assigned to the Label field.

&Y, Sample_Library_X9.enl
D @ APA 6th % -;] El & @ @ ) [a @ EE] Q& 11 M @ Quick Search Q - ”
My Library ~ Search Options * ‘sﬁrch Whole Library v | [[JMatch Case []Match Words
All References (59) ~
@Configure Syncs [Author v | |Contains v ‘ [ -
D Recently Added 0) Label  Record #  Author Year Title Rating Journal  Last Updated  Reference Type 2
E_] Unfiled (0) 62 2009 Leaf-nosed bat *k - - - Encyclo.. 5/5/2010 Encyclopedia
-@- Tedh © 80 Allen, G.. 2004 Bats: biology, behavior, ... 5/5/2010 Book
73 Avila-Fl.. 2004  Ecological, taxonomic, a... Journal ... 6/15/2018 Journal Article
= Avian Intelligence 76 Bat Con.. 2008  Bat Conservation Intern... 3/22/2013 Web Page
‘Avian Cogpnition 31 79 Binfield,... 2008 At PLoS ONE we're batt... PLoS: Pu... 3/21/2013 Blog
E_]Corvids (19 2318 Bird, C... 2009 Insightful problem solvi.. Y % Proceed.. 6/15/2018 Journal Article
@ Convids & Parrots ®) 65 Brl.nklov“. 2009 Intense echolocation ca... Journal ... 6/15/2018 Journal Art!cle
75 Chiu, C.. 2007  The role of the external... Journal ... 3/22/2013 Journal Article
i parrots @4 68 Chiu, C.... 2008  Flying in silence: Echol... Proceed... 6/15/2018 Journal Article
= Bats 2320 Clayton,.. 2009  What do jays know abo... Neurobi... 3/22/2013 Book Section
E_jchiroptera @2 2339 Delong,... 2008 Evidehfe for s‘patial rep... JAccust... 6/15/2018 Journal Art?cle
. 2285 Emery, .. 2006 Cogpnitive ornithology: .. Y Y % Philosop... 6/15/2018 Journal Article
EJ Echolocation © 2319 Emery,.. 2009 Tool use and physical c.. ¥ Current ... 3/21/2013 Journal Article
@ Echolocation OR Sonar @) 2324 Emery, .. 2007 Cognitive adaptations .. ¥ Philosop... 6/15/2018 Journal Article
# Sonar (5) 74 EUROB.. 2004 EUROBATS: The Agree... 3/22/2013 Web Page
= My Groups 2268 Fraser,.. 2011 Ravens reconcile after a.. Y % PLoS ONE 6/15/2018 Journal Article
2291 Funk, M... 2002  Problem solving skills i... Animal ... 3/22/2013 Journal Article
3 Cognition-All (33) v 2308 Goto. K... 2012 Larae-billed crows (Cor... Animal .. 3/22/2013 Journal Article v
Showing 59 of 59 references. E Layout ~

8.2 Make a Backup of the Library

If you make a mistake while copying the record number to the Label field, there is no way to undo the
change, so make a backup copy of the library before starting this process. See section 5.1.1 for instructions
on creating a backup.
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8.3 Copying the Record Number to the Label Field

e Selectall the records forwhich you intend to copy the record number to the Label field, then select
Show Selected References from the References menu. EndNote will apply the change to all
references showing in the list, so you need to limit the references showing to those you want to

change.

New Refefe

References ps Tools Window Help
Ctrl+N
Ctrl+E

Edit References
AL P e T O O S L ¢

Previous keference

ctnrPaye up

Show All References Ctrl+M
Show Selected References

Select Change/Move/Copy Fields from the Tools menu.

Tools M

Searchﬂrary... Ctrl+F

Spell Check Ctrl+Y
Cite While You Write [CWYW] >
Online Search...

Format Paper 9 >
Change/Move/Copy Fields..h

e Inthe Change/Move/Copy Fields window, select 1) the Move/Copy Fields tab, 2) Copy Field, 3) Record
Number as the field to copy from, 4) Label as the field to copy to. You will have options to insert the
record number after or before existing text in the Label field, or to replace all text currently in the
field, so if you have existing text in the field it is possible to keep it and append the record number.

Click 5) the OK button to apply your choices.

Change/Move/Copy Fields

(O Move Field

From: Record Number

@® Copy Field h

Change Fields Move/Copy Fields h

<

To: Label

év?

(@ Insert After Field's Text Don't Move Empty Fields
(O Insert Before Field's Text
(O Replace Entire Field
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e EndNote will report the number of references the change will apply to and which fields will be
affected, and ask for a confirmation. If the message shows the correct information, click the OK
button. (Reminder: There is no Undo command if you make a mistake, so check the information
in this screen for accuracy and backup the library before continuing, if you have not already done

S0.)

EndNote X

| Inthe 59 references showing in the
" library Sample_Library_X9.enl:

Copy the “Record Number" field to the end of the
“Label" field?

This operation cannot be undone. It is recommended
that your library is backed up before you make
changes.

| ok |

Cancel ‘

e When finished with the changes, EndNote will report the number of references changed. Click the

OK button to close the window.

EndNote

a Made 59 changes in 59 references.

e Thelibrary now shows the same number for the record numberand in the Label field for this library

on the original computer.

—
&N, Sample_Library_X9.enl II:-hE.
— — . = Py »
1 ® [ waao HEQAZLR @S P (& | @ aes a
My Library ~ Search Options » Search Whole Libra v | [JMatch Case []Match Words
y
All References (59) R
@Configure Sync... Author ’ ‘Contalns ’ [ ==
#DRecently Added (0) Label Record # |Author  Year Title Ratin: Journal  Last Updated  Reference Type A
9 P! yp
B unfiled O3 |62 62 2009 Leaf-nosed bat %% ¢ ¢+ Encyclo.. 6/19/2018 Encyclopedia
@'Trash o) 80 80 Allen, G.. 2004  Bats: biology, behavior, ... 6/19/2018 Book
73 73 Avila-Fl.. 2004  Ecological, taxonomic, a... Journal ... 6/19/2018 Journal Article
- Avian Intelligence 76 76 Bat Con.. 2008  Bat Conservation Intern... 6/19/2018 Web Page
.Avian Cognition 31) 79 79 Binfield,... 2008 At PLoS ONE we're batt... PLoS: Pu... 6/19/2018 Blog
E_]Corvids (19) 2318 2318 Bird, C... 2009 Insightful problem solvi.. ¥ ¥ Proceed... 6/19/2018 Journal Article
.Corvids & Parrots © 65 65 Brlr\klov.,. 2009 Intense echolocation ca... Journal ... 6/19/2018 Journal Artfcle
g 75 75 Chiu, C.. 2007 The role of the external... Journal ... 6/19/2018 Journal Article
=] Parrots @4 |eg 68 Chiu, C;... 2008 Flying in silence: Echol. Proceed... 6/19/2018 Journal Article
= Bats 2320 2320 Clayton,... 2009  What do jays know abo... Neurobi.. 6/19/2018 Book Section
E_]Chiroptera @2) 2339 2339 Delong,... 2008 Evndern.ce for s.patlal rep... J A_cousL. 6/19/2018 Journal Ar!fcle
= . 2285 2285 Emery, .. 2006 Cognitive ornithology: .. ¥ Y % Philosop... 6/19/2018 Journal Article
=] Echolocation © 12319 2319 Emery,.. 2009 Tool use and physical c.. % Current... 6/19/2018  Journal Article
@ Echolocation OR Sonar @) |2324 2324 Emery, .. 2007 Cognitive adaptations .. ¥ Philosop... 6/19/2018 Journal Article
# Sonar (5) 74 74 EUROB.. 2004 EUROBATS: The Agree... 6/19/2018 Web Page
My G 2268 2268 Fraser,.. 2011 Ravens reconcile after a.. % PLoS ONE 6/19/2018 Journal Article
y Groups 2291 2291 Funk, M... 2002  Problem solving skills i... Animal ... 6/19/2018 Journal Article
3§ Cognition-All (33) v |2308 2308 Goto. K... 2012 Larae-billed crows (Cor.. Animal ... 6/19/2018 Journal Article v
Showing 59 of 59 references. ELayou! <
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e However, when that library is synced to a second computer, the record number is no longer the
same for all records as the contents of the Label field. The label number will remain constant even
though the record number changes, and can now be used as an unchanging tracking number and
in Cite While You Write.

[ NON ] | endnote.training@outlook.com
Qo L E C gmléll;:l):sate m- Q_ Search Library >
My Library v Label Record # | Author ~ Year Title
62 31 2009 Leaf-nosed bat
a All References @ 80 42 Allen, Glover M. 2004 Bats: biology, behavior, and folklore
Q Sync Status... 73 49 Avila-Flores, R.; Medellin, R. A. 2004 Ecological, taxonomic, and physiological correlates of cave use...
9D Recently Added 76 39 Bat Conservation International, 2008 Bat Conservation International
B Unfiled 79 41 Binfield, Peter 2008  AtPLoS ONE we're batty about bats
.@. Trash 2318 56 Bird, C. D.; Emery, N. J. 2009 Insightful problem solving and creative tool modification by capti...
65 47 Brinklov, S.; Kalko, E. K. V.; S... 2009 Intense echolocation calls from two ‘whispering' bats, Artibeus ja...
o [ 75 38 Chiu, Chen; Moss, Cynthia F. 2007 The role of the external ear in vertical sound localization in the fr...
68 48 Chiuy, C.; Xian, W.; Moss, C. F. 2008 Flying in silence: Echolocating bats cease vocalizing to avoid so...
8 chiroptera 2320 19 Clayton, N. S.; Emery, N. J. 2009  What do jays know about other minds and other times?
EJ Echolocation [ 6] 2339 59 Delong, C. M.; Bragg, R.; Sim... 2008 Evidence for spatial representation of object shape by echolocati...
@ Echolocation OR Sonar (7] 2285 51 Emery, N. J. 2006 Cognitive ornithology: The evolution of avian intelligence
* Sonar (5 2319 18 Emery, N. J.; Clayton, N. S. 2009 Tool use and physical cognition in birds and mammals
2324 57 Emery, N. J.; Seed, A. M.; von... 2007 Cognitive adaptations of social bonding in birds
¥ Avian Intelligence 74 37 EUROBATS Secretariat, 2004 EUROBATS: The Agreement on the Conservation of Population...
5 " 2268 50 Fraser, O. N.; Bugnyar, T. 2011 Ravens reconcile after aggressive conflicts with valuable partners
@ Avian Cognition (31 ] .
2291 3 Funk, M. S. 2002 Problem solving skills in young yellow-crowned parakeets (Cyan...
EJ Corvids 19 2308 10 Goto, K.; Watanabe, S. 2012 Large-billed crows (Corvus macrorhynchos) have retrospective...
@ Corvids & Parrots (6]

Please note the process above would need to be repeated whenever new references were added to the
database, or the Label field would need to be manually updated. We suggest always backing up the library
before making any major changes in the library. See section 5.1.1 for instructions on creating a backup.
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8.4 Setting Cite While You Write to Use the Label Field

e Open the preferences again and 1) select Temporary Citations from the list at the left, 2) mark the
box to Use field instead of record number, 3) select Label as the field to be used, and 4) click the OK
button on Windows to save the changes and close the window (on Macintosh, click the Save button
and close the window). This change should be made by anybody who is using the Synced library,
on all their computers, so that references inserted in the document by all persons working on it will
use the Label field. If someone does not set this option, EndNote can still format the citation, but
it will not use the Label field in the citation.

EndNote Preferences X
Change Case
Display Fields Temp Citation { }
Display Fonts
Duplicates Record Number Marker: #
Find Full Te>e # Use field instead of record number:  Label h e
Folder Locations
- . \
Formatting Citation Prefix
Libraries Indicate Notes With: NOTE:
PDF Handling
Read / Unread Examples of Temporary Citations
Reference Types Typical {Smith, 1997 Label}
Sorting Citation with {see also \Jones, 1997, Label}
Spell Check Text Note Citation: {NOTE:Special recognition given to...}
Sync
Temporary Citations °
Term Lists
URLs & Links
EndNote Defaults Revert Panel o Cancel Apply

e Inthe future, temporary citations will be inserted into Word documents with the first author’s last
name, the year, and the label number you assigned instead of the record number. Temporary
citations should look something like this:

{Volk, 2012, 2376}.
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Sending .enl Files, 85
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Exporting, 102
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Not Using the Marked List, 26
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Safari oniPad, 66
EndNote Online Plug-In, 38
Sharing Groups and References, 90
EndNote Online Plug-In, 60
Capture, 66
Installing
Internet Explorer, 60
EndNote Sync, 58, 59
Setup, 58
EndNote Windows installer, 6
EndNote X9 Site Installer.dmg, 18
ENX9Inst.msi, 6, 10, 11
Importing Text Files, 44
PubMed, 51
Macintosh, 55
Windows, 53
Web of Science, 44
Macintosh, 48
Windows, 46
Installing EndNote, 6
For Administrators, 6
For Users, 9
Custom Installation for a Single-User License on Macintosh, 23
Custom Installation for a Single-User License on Windows, 16
Custom Installation for a Site License Copy on Macintosh, 17
Custom Installation for a Site License Copy on Windows, 9
Label field, 105
Label field for permanent ID number, 105
license.dat, 6, 10
PDF Files
Importing, 39
Macintosh, 40
Windows, 39
PDF Handling Preferences, 42
Macintosh, 43
Windows, 42
Preferences, Setting
PDF Handling, 42
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